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Release Notes

The following lists the significant changes for release 4.8.0 of Wordfast 4 Professional:

• Fixed issue where white space was added during concordance search

• Added File Chaining to permit joining a number of files into one working file

• Added the last saved column to Current Project Project Files tab

• Widened the analysis report pop-up

• Added the ability to skip to the next segment when 100% and Context matches encountered

• Added a column to the Current Project Project Terminology tab titled Selected

• Updated Project List and Current Project views with search for Source Language and Target
Language columns

• Moved column sorting Project List and Current Project views to icons on the right-hand side

• Increased user-friendliness of browse dialogs

• Fixed issue with having to click several times on the application to regain focus

• Fixed issue causing header alignment in columns to be off

• Fixed issue where Replace action was not working in some instances

• Fixed issue where Replace All action caused application to freeze occasionally

• Fixed Mac issue where Hide Wordfast Pro 4 option made the application crash

• Fixed Mac issue where Select Next Word action failed

• Fixed issue where Table Filter drop-down failed to retract upon completion of search

• Fixed locale issue that caused Quick Tools analysis to show no matches

• Fixed issue generating extra space to the Project List view

• Fixed issue preventing Find/Replace full circle completion

• Fixed issue causing double-click on a file to result in an error

• Fixed issue resulting in Note ID column being blank after adding several notes

• Fixed issue causing Undo to not change segment status

• Fixed issues preventing terms from being highlighted
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About Wordfast Pro 1
Wordfast Pro is a Java-based translation and editing application designed to improve the way in which
translators work. It presents translators with a collaborative environment where Translation Memory (TM)
files can be accessed quickly and efficiently. Wordfast Pro is a flexible application that can work with
desktop TM files or interact directly with a powerful TM server application. It can also operate as a stand-
alone tool to supplement existing translation workflows.

Reference: TXLF Editor Unlabeled Icons



Copyright © Wordfast, LLC 2016.   Page 9 of 227

Getting Started 2
This chapter provides the basic information to get started in Wordfast Professional (Wordfast Pro).

Wordfast Pro is installed and executed on a local computer (refer to Installing and Activating Wordfast
Pro).

Requirements

Wordfast Pro requires the following:

• Java JRE installed; if Java JRE is not present, it is installed automatically during Wordfast Pro
installation

• Activation of the full Wordfast Pro installation requires a license and registration

• Minimum RAM of 2GB

• Minimum resolution of 1366 x 768 is recommended

• Operating systems: Microsoft Windows 7 and 8, OSX 10.9+

Installing and Activating Wordfast Pro

Wordfast Pro is installed on a local computer as described here.

To install and activate Wordfast Pro:

 1. Download the Wordfast Pro installer from the website http://www.wordfast.com/ to a local hard drive.
 2. Run the installer.

Wordfast Pro opens in Demo Mode.

To activate Wordfast Pro, a license must be obtained and registered either online or offline.

  Note:

Wordfast Pro demo mode provides an opportunity to view and try out the functions with limitations.

With a non-licensed Wordfast Pro, you are limited to creating bilingual projects and storing up to 500
translation units in your Translation Memory.

 3. Purchase a Wordfast Pro license through the website http://www.wordfast.com/ and the Activation
Key is returned by email.

Refer to:

• Online Activation

• Offline Activation

http://www.wordfast.com/
http://www.wordfast.com/
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Online Activation

For online activation, use the Activation Key returned in an email.

 1. Open Wordfast Pro.
 2. Click the Help tab.

 3. Click License Management.
 4. Click Online Registration.

 5. Enter the returned activation key into the Activation Key field.
 6. Click OK.
 7. Restart Wordfast Pro.
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The license is now active.

  Note:

To resolve any license issues, log in to Wordfast Pro and select Support > Hotline.

Offline Activation

For an offline activation, a License file is returned in an email. This license file should be saved to a
known location on the computer where Wordfast Pro is installed (preferably the Wordfast program
folder).

To activate Wordfast Pro offline:

 1. Open Wordfast Pro.
 2. Click Help.
 3. Click License Management.
 4. Click Manual Registration.

 5. Insert the returned activation key into the Activation Key field.
 6. Click Generate on the Manual Registration dialog box.

The text string "Copy the string below..." is returned in the text box below the instruction text.
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 7. Copy this text string into an email and send it to the email address provided on the Manual
Registration dialog box below the Activation Key input field (shown above).

 8. Copy the license file that is returned in an email from Wordfast to the computer containing Wordfast
Pro.

 9. From within the Manual Registration dialog box, browse to the license file.
 10. Click OK.
 11. Restart Wordfast Pro.

The license is now active.

  Note:

To resolve any license issues, log in to Wordfast Pro and select Support > Hotline.

Managing Licenses

Below are the procedures for managing Wordfast Pro licenses:

• Re-installing Licenses • Verifying Current License • Update Notification

  Note:

Upon opening Wordfast Pro, an update notification appears when there are newer versions available
(see Project Help Tab).

Re-installing Licenses

To initiate a license re-installation for Wordfast Pro:

 1. Obtain a new activation code for Wordfast Pro through the website http://www.wordfast.com/.
 2. Follow the instructions for:

•    Online Activation •    Offline Activation

Verifying Current License

To verify the current Wordfast Pro license:

 1. Open Wordfast Pro.
 2. Select Help.
 3. Click License Management.

http://www.wordfast.com/
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The License Manager activation dialog box appears.

 4. Verify the license expiration date in the text below the Activation Key field.

The license status, as shown below, appears just below the Activation Key.

License will expire in 254 day(s)

Update Notification

Upon opening Wordfast Pro, an update notification appears when there are newer versions available.

Alternatively, check for updates as follows:

 1. Click Help.
 2. Click Wordfast 4 Update.
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A list of available updates appears (as shown).

Starting Wordfast Pro

Wordfast Pro opens in the Projects list tab.

  Note:

The Projects, Location, Source Language, and Target Language columns can be ordered by

typing the first letter or two of the item to head the list then clicking  or  to the far right. These
columns can be searched by typing in a string of characters that are contained in the entry of interest.
When a matching, unique string is found in an entry, only that entry is presented in the list. To restore

the list, click the Clear Filters icon .
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The Wordfast 4 drop-down menu.  

Project Files Perspective

The following shows the options on the Project Files tab.

  Note:

The Files column can be ordered by typing the first letter or two of the item to head the list then

clicking  or  to the far right. These columns can be searched by typing in a string of characters that
are contained in the entry of interest. When a matching, unique string is found in an entry, only that

entry is presented in the list. To restore the list, click the Clear Filters icon .
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For a list of the actions that can be taken at the project level refer to Project Files Tab.

Reference:

• TXLF Editor—Translation Tab

TXLF Editor Perspective

The following shows the options on the TXLF Editor Translation tab.
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Icon Name Description

Function Tabs Tabs that access the various tools of the application.

Tools Ribbon Tools available on the active tab.

File Name

List of open files. Multiple files can be open at one time and appear as
separate tabs in the list. 
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Icon Name Description

Table Filter
Row of fields that are used to provide the filter criteria and control
searches.

Source Column

Numbered source segments that are sections of paragraphs as
presented in the editor after a file is segmented for translation.

    

Target Columns

Translation work area including:

• Target column (right column), contains language translation,
entered or leveraged

• Segment Score column contains the percentage of match found
in the TM

• Status column indicates the status of that segment
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Icon Name Description

Editor Tabs

They are:

• TM Lookup

»  With More Options     

• Notes

• Segment History

• Metadata

• Transcheck (0)

    

Terminology

Area for searching and adding terms to terminology lists (glossaries), if
enabled.
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Basic Options 3
Wordfast Pro is executed by double-clicking the Wordfast Pro 4 icon on the PC desktop. Wordfast
opens with the Projects tab (Projects List) selected. Selecting and opening a project moves to the
Project Files tab. From this Project Files tab one can select a file and open it with the TXLF Editor. In
doing so, the tab is opened (default).

For the basic options of:

• Project Files tab, refer to Project Files Tab

• TXLF Editor File tab, refer to TXLF Editor—File Tab

• TXLF Editor Edit tab, refer to TXLF Editor—Edit Tab

•
• TXLF Editor Formatting tab, refer to TXLF Editor—Formatting Tab

• TXLF Editor Translation tab, refer to TXLF Editor—Translation Tab

• TXLF Editor Terminology tab, refer to TXLF Editor—Terminology Tab

• TXLF Editor Review tab, refer to TXLF Editor—Review Tab

• TXLF Editor Help tab, refer to Project Help Tab

References:

• Preferences • Using Transcheck
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Project Management 4
Project management includes creating projects, preparing files for translation, and managing the
translation process (refer to Application Tabs). Translation-related files and the rules for a given
translation must be set up before beginning a translation. The tasks required to manage a project are:

• Creating Projects • Opening Projects • Removing Projects

Creating Projects

In Wordfast Pro, it is necessary to create a project before any file translation can take place. A TXLF
file can only be opened for translation after the project is created or opened. The project is a working
environment that identifies the settings for the source and target language, Translation Memory (TM),
glossary, and other user information. The following tools are provided for creating projects:

•    Simple Project Creation •    Advanced Project Creation

Simple Project Creation

To create a project using the standard (simple) interface:

 1. Click the Create Project Drop-down Symbol (downward pointing triangle) as shown below and the
menu opens.

 2. Click Use the simple project creator from the Create Project drop-down menu.



Chapter 4 - Project Management Wordfast

Copyright © Wordfast, LLC 2016.   Page 22 of 227

The Simple Project Creation dialog box appears.

 3. Enter a project name in the Project Name field.
 4. Select the source language from the left Languages drop-down list.
 5. Select the target language from the right Languages drop-down list.
 6. To browse to project files:

• Click Add Files

• Or, drag the file(s) from a folder into the Files list area

The selected files are listed in the Files list.

  Note:

A green check-mark in the Valid column indicates the file is acceptable. A red X in the Valid column
indicates that the file type is not supported by Wordfast Pro filters.

 7. Select Translation Memory for this project using one of the following options (radio buttons):
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Radio Button Description

Add TM Connect to an existing local Translation Memory (TM)
database.

Use Existing Connect to an existing Translation Memory database from
another project.

Create New Build a new Translation Memory database.

Do not use TM for this project No Translation Memory is to be used for this project.

 8. Click Finish.

Wordfast Pro analyzes the file(s), then presents the summary pop-up.
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Advanced Project Creation

To create a project using the advanced project creation tool:

 1. Click the Create Project Drop-down Symbol (downward pointing triangle) as shown below and the
menu opens.

 2. Select Use the advanced project wizard from the Create Project drop-down menu.

 3. Select an option for this project. The options are listed in the following table.
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Option Description

Create New Project Begin from nothing in creating this project.

Create Project based on the
previous Project

Begin with the profile of some previously created, local
project.

Create a Project based on a
Project from the list

Build a new project with initial content from a selected project
found in the project list.

Location Browse to a location where the new project is to be stored.

 4. Enter a project name in the Project Name field.
 5. Click Next.

The Language Selection dialog
box appears.  

 6. Select the source and target languages:

a) To change the selected originating language, select a different language from the Source
Language drop-down list.

b) To change the selected translated language or add another language (multiple target languages
are supported), select a different language from the Target Language drop-down list.

c) Click Next.

The Add Source Files dialog box appears.
 7. Add files using one of the following methods:
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• Drag the file(s) into the
file list area.

• Click Add File and select
the file(s).

 8. Click Next.

The Translation Memory dialog box appears.
 9. In the Translation Memory dialog box, select:
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• Create a TM, then

◦ Enter unique name
for the new project

◦ Select the
languages

◦ Provide location for
the project files

◦ Select TM Priority

◦ Select whether TM
is to be Read-only

• Add Local, then

◦ Select the TM
folder.

◦ Click Next.

• Add Remote, then

◦ Select the TM
Server or WF
Server

◦ Refer to
Connecting
Remote TMs

• Modify to change one or
more selected TMs.

• Remove to delete one or
more selected TMs.

 10. Click Next.

The Terminology dialog box appears.
 11. In the Terminology dialog box provide the required information.



Chapter 4 - Project Management Wordfast

Copyright © Wordfast, LLC 2016.   Page 28 of 227

• Create: initiate a new,
local Terminology
database (Termbase).

• Add Local: select an
existing local Termbase
to be selected through
browsing.

• Add Remote: select an
existing Term Manager
connection

• Modify: edit selected
Terminology (local or
remote).

• Remove to delete a
selected terminology.

 12. Click Next.

The References dialog box appears.
 13. Select a set of files using one of the following options:

• Add File: select an
existing reference file

• Add Folder: select
an existing folder for
reference files

• Remove: delete selected
reference files from the
list

 14. Click Finish.



Chapter 4 - Project Management Wordfast

Copyright © Wordfast, LLC 2016.   Page 29 of 227

The document files are
analyzed. A Progress bar
shows the progress as percent
complete.

The Project Creation Summary
appears upon completion.  

Opening Projects

Projects must be opened before any files can be opened or translation and related operations can take
place.

Submissions being assigned from Project Director are downloaded from Project Director by running a
Get Translation Files Offline. The files are bundled into the GlobalLink© Package (GLP) format and
then into a ZIP file. The content of that ZIP file is then imported into Wordfast. Refer to Using GLP Files.

  Note:

The Projects, Location, Source Language and Target Language columns can be ordered by

typing the first letter or two of the item to head the list then clicking  or  to the far right. These
columns can be searched by typing in a string of characters that are contained in the entry of interest.
When a matching, unique string is found in an entry, only that entry is presented in the list. To restore

the list, click the Clear Filters icon .

To open a project from the Wordfast Pro Project List:

 1. Select a project.
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 2. Click Open Project or double-click the project.

The Project Files tab appears as shown.

References for details of the Wordfast Pro Project tabs:

• Project Files Tab

• Project Terminology Tab

• Project Reference Files Tab

• Project Translation Memory Tab

• Reports Tab

• Project Help Tab

Using GLP Files

A GlobalLink Package (GLP) enables a project to be passed around in a coherent structure. The GLP
comprises everything required to send a project to a team member permitting that member to work on
the project. Using this option, projects can be transferred between Wordfast Pro installations without
requiring a manual setup on the importing Wordfast Pro installation. A GLP can contain both complete
and incomplete projects. GLPs can include:

• Project files: Bilingual SDL XLIFF files and reference files

• Local and remote project Translation Memory
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• Local and remote main Translation Memory references

• Local and remote termbases references

• Auto-Suggest dictionaries

• Automated translation provider connection details

• The Analyze and Word Count reports (generated during package creation)

• Project settings

  Note:

GLP files do not include the project source files but they can be added as reference files when you
create a the package on the Export Package dialog box under the Resources To Include In Export

A completed package can be sent by email, posted on an FTP site, or some other method to make the
project files available to another person.

• Importing Packages • Exporting Packages

Removing Projects

To remove a project from the resident projects list:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select the project to remove.

 3. Click Remove Project.

The Projects List reappears with the selected project no longer in the list.

  Note:

After a project is removed it can no longer be retrieved without adding it back into the project.
Removed projects are not erased and can be retrieved from the original folder using Add.
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Working with Projects 5
When Wordfast Pro is started, the Projects tab lists all resident projects from which one (and only one)
can be selected and opened. Refer to Opening and Translating Files.

With a project selected, the following tasks are available:

• Adding Files

• Translate Project Files

• Modifying Projects

• Analyzing Projects

• Running Export Notes Report

• Exporting Packages

• Adding Folders

• Closing Projects

• Cleaning Up Files

• Running Segment Changes Report

• Importing Packages

• Removing Files

References:

• Translating Files • Using Transcheck

Adding Files

To add files to a project:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Open the project.
 

3. Click Add Files.     
 4. In the file Open navigation dialog box, browse to the file and select it.
 5. Click Open.
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The file is analyzed and a
Files Report appears.  

 6. Click OK.

The Report File dialog box closes and the added files are then listed.

Adding Folders

To add files for translation from a folder to a project:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Open the project.

 3. Click Add Folders.
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The Add Folder dialog box
appears.  

 4. Select:

• A folder

• Make New Folder
 5. Click OK.

Translate Project Files

To translate the project files see Translating Files.

Closing Projects

To close a project on the Project Files tab:

 1. Click Close Project.
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The project is closed and the Projects list tab is reopened (as shown).

Modifying Projects

To modify a project from the Projects tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select a project.
 

3. Click Modify Project.     

The Modify Project
dialog box appears.  

 4. Modify the target language as necessary.
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 5. Change the project name as necessary.
 6. Make the target language changes as necessary by selecting from the drop-down list.
 7. Click OK.

Cleaning Up Projects

After files are translated, the translation project is ready for a clean up and an update to the Translation
Memory (TM) files. The project clean-up process requires a manual initiation. Following this clean-up an
automated process removes the source segments and restores the files to their original format.

To clean up and update the Translation Memory from the Project Files tab:

 1. Click Project Clean Up.

The Project Clean Up dialog box appears.
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 2. Select the languages to clean up:

• All Language Pairs

• Specific Language Pairs

• Single Language Pair
 3. Select where the translated files are to be placed:

• Place translated files in the project folder

• Place translated files in the original path of source files

• Enter the location to put translated files
 4. Select Create subfolders by language as appropriate.
 5. Select Add language suffix to the translated file name as appropriate.
 6. Select TM Overwrite Options.
 7. Select the TM(s) to Update.
 8. Click Clean Up.

Cleaning Up Files

The Project Manager is responsible for the cleaning up of translated files and selecting the TM update
options. To execute this manual process refer to Cleanup.

Analyzing Projects

In Analyzing Projects, files for translation are analyzed against a Translation Memory to leverage
reusable content and execute a pre-translation (refer to Project Files Tab).

To analyze files from the Project Files tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 

2. Select the project and click Open Project.     
 

3. Click Analyze Project on the Project Files tab.     

The Project Analyze dialog box appears.
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 4. Select the file(s) to be analyzed.
 5. Select the appropriate Analysis Options as follows (refer to Configuring Translation Memory):

a) Select Pretranslate to create translated TXLF files, including the options:

• Match percentage criteria

• Copy all tags on segments when there is no TM match

• Copy segment source to target when there is no TM match

• Do nothing

b) Select Report Settings:

• Show only analysis report summary

• Export Report

◦ Report Name

◦ Report Type

◦ Report Location

c) Translation Memory, select one or more TM to use during this analysis.
 6. Click Analyze.
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A pop-up appears showing the report percentage
progress.

 

 

The analysis completes and the Report File
summary appears.  

Running Segment Changes Report
 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 

3. Click Segment Changes Report.     

The Segment Changes Report dialog box appears.

 4. Make the required selections.
 5. Click Export.
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The following example shows an exported Segment Changes report.
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Running a Segment Changes Report also presents a Segment Changes Summary pop-up as
shown.

 6. Click OK.

Running Export Notes Report

To export notes in Microsoft Word format:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 

3. Click Export Notes under the Project Files tab.     

The Export Notes Report dialog box appears.

 4. Click Export.
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The export summary
appears.  

 5. Click OK.

Importing Packages

Using the Import Package option, a GLP project file can be imported from another Wordfast Pro
installation fully and not require any setup.

To import project files:

 1. Click Import Package (or drag and drop a GLP file).

The Files and TXLF File Location columns can be ordered by typing the first letter or two of the

item to head the list then clicking  or  to the far right. These columns can be searched by typing in
a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

The Import Package dialog box appears.
 2. Use Browse to locate and select the GLP file.
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The Import Package dialog box is populated with the selected file name and a drop-down list of
available projects in the GLP.

 3. Select a GLP file.
 4. Click one of the following options:

• Update A Current Project for an existing project and provide the project name, then select:

◦ Only update existing project TXLF files

◦ Update existing and add new files

• Create New Project for a new project and provide a project name and location, then provide:

◦ The new Project Name

◦ The new project Location
 5. Optional: Select Open Project After Import to open the updated or new project when the import

completes.
 6. Click Import.
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If Open Project After Import was checked, the current project view opens in the Project Files tab
listing the TXLF files for translation.

Exporting Packages

A GlobalLink Package (GLP) of project files comprises everything required for a project. Using the
Export Package option, a complete project package can be shared with other Wordfast Pro installations
without requiring a manual setup of the project on the receiving Wordfast Pro.

To export a project package (GLP):

 1. On the Projects tab, select the project.

The Files and TXLF File Location columns can be ordered by typing the first letter or two of the

item to head the list then clicking  or  to the far right. These columns can be searched by typing in
a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 2. Click Export Package.
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The Export Package dialog box appears.

 3. Select export type:

• Entire Project

• Specific target languages and resources selectively, including:

◦ Source Files

◦ TXLF Files
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◦ Glossaries

◦ Translation Memories

◦ Reference Files

◦ Blacklists
 4. Select a naming convention.

• GLP Name to have
the export process
name the file

• Custom Name to
specify the name to
be used

 5. Select a location to receive the GLP file.
 6. Click Export.

The exported GLP is built and saved to the selected folder. This GLP file can now be passed on to a
different Wordfast Pro installation.

Removing Files
 1. Go to the Projects list tab (refer to Opening Projects for more information).
 2. Select and open the project.
 3. Select the file to be removed.

 4. Click Remove File(s).

The file is removed from the current project.
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Working with Project Translation Memory 6
Translation Memory (TM) is designed to provide maximum content re-use and to facilitate collaboration
between globally distributed localization resources.

Translation Memory (TM) can be managed both by project managers and translators. Translation
Memory management is accessed from the Project TM tab and includes the following tasks:

• Creating Local Translation Memory

• Connecting Remote TMs

• Modifying Local TMs

• Importing Translation Memory

• Removing Translation Memory

• Adding Local TMs

• Opening Local Translation Memory

• Copying Translation Memory

• Exporting Local Translation Memory

References:

• Configuring Translation Memory

• Customizing Colors
• Configuring Penalties

• Translation Memory Color Representations

Creating Local Translation Memory

A new local Translation Memory can be created for an existing project as described below.

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project TM tab, click Create Local.

The Translation Memory and Location columns can be ordered by typing the first letter or two of

the item to head the list then clicking  or  to the far right. These columns can be searched by typing
in a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.
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The Translation
Memory Create dialog
box appears.  

 4. Enter the Translation Memory information as described in the following table.

Option Description

Name
Enter a TM name. A good practice is to enter a name that includes a client or
organization name and the TM's language.

Target Language The target language selection is limited to those declared in the project.

Location The location where the new TM is to be saved.
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Option Description

Priority
This relative priority determines the sequence of reference during translation
where the Primary TM is first to be referenced and only one TM can be
designated as primary.

Selected
Checking Selected indicates that this TM is to be used for the current
project.

Read Only Selecting this option prevents any write action to the TM.

 5. Click OK.

The new Translation Memory is created and reflected in the project Translation Memory list.

Adding Local TMs

Adding a local Translation Mmeory is for WFP-4 format (different from WFP-3) Translation Memory only.
To add local Translation Memory to an existing project from the Project TM tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project TM tab.
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 4. Click Add Local.

The Browse For Folder dialog box appears (shown above).
 5. Select a Translation Memory.
 6. Click OK.

The selected local Translation Memory is added to the project and listed in the project Translation
Memory tab.

 

 

 

 

 

Connecting Remote TMs

While Wordfast Pro is a locally executed program, it can access remote Translation Memory (TM). The
types of remote TMs that can be connected are: GLTM/WFTM and TM Server 4.

To connect to a remote TM:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project TM tab.
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 4. Click Connect To Remote on the Project TM tab as shown.

The Connect to Remote TM dialog box appears.
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Adding Translation Memory Connections

To add a remote Translation Memory using a TM or WF server:

 1. Go to the Connect to Remote TM dialog box.

 2. To Add a TM Server:

a) Click the TM Server tab.

b) Enter a unique name in the Symbolic Name field.

c) Enter the remote Translation Memory URL (provided by PM) in the URL field following the
example template shown in that field.

  Note:

The URL settings are populated automatically as provided within the URL string.

d) Select a Priority from the drop-down.

e) Click Selected to enable this Translation Memory.

f) Click Read Only to prevent modifications.
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 3. To Add a WF Server:

a) Click the WF Server tab.

b) Enter a unique name in the Symbolic Name field.

c) Enter the remote Translation Memory URL (provided by PM) in the URL field following the
example template shown in that field.

  Note:

The URL settings are populated automatically as provided within the URL string.

d) Click Use Cleanup Password if appropriate and supply the password.

e) Select a Priority from the drop-down.

f) Click Selected to enable this Translation Memory.

g) Click Read Only to prevent modifications.
 4. Click OK.
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Opening Local Translation Memory

Current Translation Memory can be opened and edited if and only if it is local.

To open the current projects Translation Memory from the Project TM tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Select a Translation Memory file.

The Translation Memory and Location columns can be ordered by typing the first letter or two of

the item to head the list then clicking  or  to the far right. These columns can be searched by typing
in a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 4. Click Open TM (shown in preceding example).
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The Translation Memory dialog box appears.

  Note:

Only local Translation Memory can be opened and edited through this function.

Modifying Local TMs

Local Translation Memory can be edited from the Project TM tab as follows:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project TM tab.

The Translation Memory and Location columns can be ordered by typing the first letter or two of

the item to head the list then clicking  or  to the far right. These columns can be searched by typing
in a string of characters that are contained in the entry of interest. When a matching, unique string is
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found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 4. Click Modify TM (shown above).

The modify Translation
Memory dialog box
appears.  

In this example the Read
Only option was selected to
protect the Primary TM.

 5. Click OK to save changes.

Copying Translation Memory

Local Translation Memory can be copied to a local file. The file copy is in the Wordfast Pro 4 format and
cannot be used with Wordfast Pro 3.
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To copy a Translation Memory:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project TM tab.
 4. Select a translation memory.

The Translation Memory and Location columns can be ordered by typing the first letter or two of

the item to head the list then clicking  or  to the far right. These columns can be searched by typing
in a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 5. Click Copy TM (shown above).

The Copy TM dialog
box appears.  

 

Note: If Flip
Languages is selected,
the source TM and
target TM languages
are reversed.

 6. Enter a name for the copy and its destination folder.
 7. Click Copy.
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Importing Translation Memory

To import a translation memory profile:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project TM tab.

The Translation Memory and Location columns can be ordered by typing the first letter or two of

the item to head the list then clicking  or  to the far right. These columns can be searched by typing
in a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 4. Click Import TM.
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The Import Translation
Memory dialog box
appears.  

 5. Make selections.

The file formats supported for import are:

• WF Classic TM: The format supported by Wordfast Classic and Wordfast Pro 3.

• TMX: The standard format supported by all translation tools.
 6. Use the Browse For Folder to identify a folder to receive the TM copy.
 7. Click Browse.

a) Select the TM file.

b) Click Open.
 8. Click OK.

The Create Translation Memory dialog box returns with all fields populated.
 9. Click OK.

The new TM is created in the specified folder.

Exporting Local Translation Memory

To export a local Translation Memory from the Project TM tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project TM tab.
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The Translation Memory tab appears.

The Translation Memory and Location columns can be ordered by typing the first letter or two of

the item to head the list then clicking  or  to the far right. These columns can be searched by typing
in a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 4. Select the Translation Memory file to export.
 5. Click Export TM.

The Export Translation
Memory dialog box
appears.  
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 6. Select a Translation Memory.

  Note:

The selected Translation Memory file and export type can be changed using their respective drop-
down lists.

 7. Select the export file type.
 8. Browse and select the save File path.
 9. Click OK.

A confirmation appears upon completion.

Removing Translation Memory

To remove Translation Memory from the current project without erasing the file:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Click the Project TM tab.

The Translation Memory and Location columns can be ordered by typing the first letter or two of

the item to head the list then clicking  or  to the far right. These columns can be searched by typing
in a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 3. Select the TM to delete.
 4. Click Remove TM (as shown in the preceding example).
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A confirmation appears.  

 5. Click Yes to complete the removal.
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Working With Terminology 7
Project Terminology is used to manage the related glossary and blacklist terms. Projects utilize a
collection of terms used in previous translations to facilitate new translations. These terms consist of both
preferred (Glossary) and rejected (Blacklist) terms.

Below is a list of Terminology related activities and useful references:

• Working with
Glossaries

• Working With Blacklists • Modifying and Removing
Glossaries, Blacklists

References:

• Configuring Terminology • Customizing Colors

Working with Glossaries

A glossary is a list of source terms and their preferred translations. For example, a list could include
information as shown in the table below.

Source Target

Translation Memory mémoire de traduction

Translation Unit unité de traduction

Data Transfer Rate taux de transfert de données

International Translators Federation Fédération Internationale des Traducteurs

See the following:

• Creating Local Glossary

• Opening Local Glossaries
• Adding Local Glossaries

• Importing Local Glossary
• Connecting Remote

Glossary

• Exporting Local Glossaries

Creating Local Glossary

To create a local glossary from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
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 3. Click the Project Terminology tab.

The Project Terminology tab appears.

 4. Click Create Local (shown above).

The Create Glossary dialog
box appears.  

 5. Enter a unique name for this new glossary.
 6. Select the Target Language.
 7. Browse to a folder where the new glossary is to be saved.
 8. Optional: Select Read Only to prevent changes to the glossary.
 9. Click OK.

Adding Local Glossaries
 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.
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The Project Terminology tab appears.

 4. Click Add Local.

The Browse For Folder dialog box appears.
 5. Select the glossary folder.
 6. Click OK.

The glossary is added and the Project Terminology tab reloaded with the added glossary showing.

Connecting Remote Glossary

To connect to a remote glossary from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.
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The Project Terminology tab appears.

 4. Click Connect To Remote.

The Connect to Term Manager dialog box appears.
 5. Enter a unique name in the Name field.
 6. Select a target language from the drop-down list.
 7. Enter the URL (provided by the PM) in the URL field following the example template shown in that

field.

  Note:

The URL settings are populated automatically as provided within the URL string.

 8. Click Read Only to prevent modifications.
 9. Click Create Blacklist Connection to include a blacklist.
 10. Click OK.
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Opening Local Glossaries

To open a local glossary from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project Terminology tab.

The Project Terminology tab appears.

The Glossary Name and Location columns can be ordered by typing the first letter or two of the

item to head the list then clicking  or  to the far right. These columns can be searched by typing in
a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 4. Click Open Glossary (shown above).
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The Glossary Editor tab appears.

Importing Local Glossary

To import a glossary or to add to an existing glossary from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project Terminology tab.
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The Project Terminology tab appears.

The Glossary Name and Location columns can be ordered by typing the first letter or two of the

item to head the list then clicking  or  to the far right. These columns can be searched by typing in
a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 4. Select the glossary to import.
 5. Click Import Glossary (shown above).
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The Import Glossary dialog box appears.

 6. Select a file type from the two options:

• Tab delimited text file (.txt)—Wordfast Classic and Wordfast Pro 3 format

• Term Base eXchange (.tbx)

 7. Enter or browse and select a glossary.
 8. Select one of the following options:

• Create New Glossary to import the first terminology file for the project

• Import Into Existing Glossary to add terms to the existing glossary
 9. Click OK to save the glossary changes.
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Exporting Local Glossaries

To export a local glossary from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Project Terminology tab.

The Project Terminology tab appears.

The Glossary Name and Location columns can be ordered by typing the first letter or two of the

item to head the list then clicking  or  to the far right. These columns can be searched by typing in
a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 4. Select a glossary.
 5. Click Export Glossary (shown above).
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The Export Glossary dialog box appears.

 6. Re-select the Glossary name (if necessary).
 7. Select one of the following export types:

• Tab delimited text file (.txt)—Wordfast Classic and Wordfast Pro 3 format

• Term Base eXchange (.tbx)

 8. Enter the new file name and/or browse for a location to receive the glossary.
 9. Click OK.

The glossary is exported and saved at the specified location.

Working With Blacklists

A blacklist is a list of terms used in conjunction with Transcheck to ensure that unwanted terms are not
used in translation. Refer to the following tasks for adding and editing a blacklist.

• Creating Local Blacklists

• Importing Local Blacklists
• Adding Blacklists

• Exporting Local Blacklists
• Opening Local Blacklists

References:
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• Modifying and Removing Glossaries, Blacklists

Creating Local Blacklists

To create a local blacklist from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.

The Project Terminology tab appears.

 4. Click Create Local in the Blacklist section of the Project Terminology tab.

The Create Blacklist dialog box
appears.  

 5. Enter a unique name for this blacklist.
 6. Select a language.
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 7. Browse to the destination folder.
 8. Select Read Only if the list is to be locked to prevent changes to the blacklist.
 9. Click OK.

Adding Blacklists

A blacklist includes words or phrases that should not be used in the target segment.

To add a blacklist from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.

The Project Terminology tab appears.

 4. Click Add Local.

The Blacklist browse dialog box appears.
 5. Browse for the blacklist to be added.
 6. Select the blacklist.
 7. Click OK.

The newly created or selected blacklist is listed under Blacklists.
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Opening Local Blacklists

To open a local blacklist from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.

The Project Terminology tab appears.

 4. Select a blacklist.
 5. Click Open Blacklist (shown above).
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The Blacklist Admin dialog box appears.

  Note:

To resize a column, point to the right edge of the column's header with the mouse and a pair of
opposing arrows appear separated by two vertical bars. Drag to increase or decrease the column.

To modify a given blacklist's Read Only status refer to Modifying Local Blacklists.

Importing Local Blacklists

To import a local blacklist from the Project Terminology tab

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.
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The Project Terminology tab appears.

The Blacklist Name and Location columns can be ordered by typing the first letter or two of the

item to head the list then clicking  or  to the far right. These columns can be searched by typing in
a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 4. Click Import Blacklist (shown above).

The Import Blacklist dialog
box appears.  

 5. Select the File Type.
 6. Browse and select the Import File.
 7. Select to create a new blacklist or add to a blacklist.
 8. If adding, select the existing blacklist from the drop-down list.
 9. Select how to handle duplicate terms.
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 10. Select to Clear before import replace the existing blacklist.
 11. Click OK.

Exporting Local Blacklists

To export a blacklist (local) from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.

The Project Terminology tab appears.

The Blacklist Name and Location columns can be ordered by typing the first letter or two of the

item to head the list then clicking  or  to the far right. These columns can be searched by typing in
a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 4. Click Export Blacklist (shown above).

The Export Blacklist dialog box
appears.  



Chapter 7 - Working With Terminology Wordfast

Copyright © Wordfast, LLC 2016.   Page 79 of 227

 5. Browse to or enter the path and file name of the blacklist to export.
 6. Click OK.

A confirmation pop-up appears at completion.

Modifying and Removing Glossaries, Blacklists

The Options section of the Project Terminology tab includes the tools to modify and remove glossaries
and blacklists. These tools are:

• Modifying Local Blacklists

• Modifying Local Glossary
• Removing Local Glossary

Modifying Local Blacklists

To change the Read Only status for blacklists from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.

The Project Terminology tab appears.

 4. Select a blacklist.
 5. Click Modify.
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The Modify Blacklist dialog
box appears.  

 6. Select Read Only to prevent changing the blacklist.
 7. Click OK

Modifying Local Glossary

To change a local glossary's Read Only status from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.
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The Project Terminology tab opens.

 4. Select the glossary to modify.
 5. Click Modify.

The Create/Modify Glossary dialog box appears.
 6. Select Read Only to prevent further modifications.
 7. Click OK to complete the removal.

Removing Local Glossary

To remove a local glossary from the Project Terminology tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Project Terminology tab.
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The Project Terminology tab appears.

The Glossary Name and Location columns can be ordered by typing the first letter or two of the

item to head the list then clicking  or  to the far right. These columns can be searched by typing in
a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 4. Select the glossary to be removed.
 5. Click Remove Glossary (shown above).

A remove confirmation pop-
up appears.  

 6. Select Do not warn me... to avoid this pop-up in the future.
 7. Click Yes to complete the removal.
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Reports 8
The Reports tab provides the following tools to view and manage project analysis and clean up reports.

• Opening Reports • Exporting Reports • Removing Reports

Opening Reports

To open a report from the Reports tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. On the Project Files tab, click the Reports tab.

The Reports tab appears.

The Report Name and Location columns can be ordered by typing the first letter or two of the item to

head the list then clicking  or  to the far right. These columns can be searched by typing in a string
of characters that are contained in the entry of interest. When a matching, unique string is found in an

entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon .

 4. Select a report to open.
 5. Double-click the selected report file.
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The report file summary appears (as shown).

Exporting Reports

The Reports tab includes an option to Export reports in a given project to a number of formats.

To export reports from the Reports tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Select the Reports tab.
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The Reports tab appears listing all reports found in the selected project.

The Report Name and Location columns can be ordered by typing the first letter or two of the item to

head the list then clicking  or  to the far right. These columns can be searched by typing in a string
of characters that are contained in the entry of interest. When a matching, unique string is found in an

entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon .

 4. Select a format from the drop-down menu (shown in the preceding example).

The export formats available are:

• Export report as CSV format

• Export report as HTML format

• Export report as XLS format

• Export report as PDF format

The Save As dialog box appears.

 5. Provide a folder path and file name for the report.
 6. Click Save.

The report is saved in the identified folder under that file name provided.
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Removing Reports

The Reports tab includes an option to remove unwanted reports from a given project.

To remove unwanted reports from the Reports tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Select the Reports tab.

The Reports tab opens listing any reports found in the selected project as shown.

The Blacklist Name and Location columns can be ordered by typing the first letter or two of the

item to head the list then clicking  or  to the far right. These columns can be searched by typing in
a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

 4. Select a report to delete.
 5. Click Remove Report.
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Project Reference Files 9
Reference files can be included with a project to provide context to the translation effort or to include
additional information that is not to be translated.

The Reference Files tab includes options to:

• Adding Reference Files

• Opening Reference Files
• Showing Instructions

• Removing Reference Files

Adding Reference Files

To add reference files from the Reference Files tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Reference Files tab.

The File Name and Location columns can be ordered by typing the first letter or two of the item to

head the list then clicking  or  to the far right. These columns can be searched by typing in a string
of characters that are contained in the entry of interest. When a matching, unique string is found in an

entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon .

 4. Click Add Files.
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The Open file dialog box appears as shown.

 5. Select the file to add.
 6. Click Open.

Opening Reference Files
 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select a project.
 3. Click Open Project.
 4. Click the Reference Files tab.

The File Name and Location columns can be ordered by typing the first letter or two of the item to

head the list then clicking  or  to the far right. These columns can be searched by typing in a string
of characters that are contained in the entry of interest. When a matching, unique string is found in an

entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon .
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 5. Select a file.
 6. Click Open File.
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The selected file opens in Microsoft Word.
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Showing Instructions

When a submission is created in Project Director using Add Submission on the Submit tab, specific
instructions can be attached to the submission for the translator and reviewer. These instructions are
then available for viewing through the Reference Files tab Options section.

To show the opened project instructions from the Reference Files tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Reference Files tab.

The Reference Files tab appears.

The File Name and Location columns can be ordered by typing the first letter or two of the item to

head the list then clicking  or  to the far right. These columns can be searched by typing in a string
of characters that are contained in the entry of interest. When a matching, unique string is found in an

entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon .

 4. Click Show Instructions.
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The instructions file list appears.
Instructions are optional
and frequently there are no
instructions and No instructions
appears.

 

 

Note: Instructions can only
be added from within Project
Director.

  

 5. Click OK.

Removing Reference Files

To remove files from the opened project through the Reference Files tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Reference Files tab.
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The Project Reference Files tab appears.

The File Name and Location columns can be ordered by typing the first letter or two of the item to

head the list then clicking  or  to the far right. These columns can be searched by typing in a string
of characters that are contained in the entry of interest. When a matching, unique string is found in an

entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon .

 4. Select the reference file to remove.
 5. Click Remove File(s).

The selected file is removed from the project and the reference file list.
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Translating Files 10
After completing the initial steps of creating a project, opening Translation Memory, and importing a
glossary the project is ready for translation. The translation process includes the following tasks:

• Opening and Translating a File

• Using Glossaries

• Finding and Replacing Content

• Using Notes

• Using Transcheck

• Enabling Auto Propagation

• Leveraging Repetitive Content

• Using Translation Memory

• Working with Tags

• Using Table Filter

• Working with Segments

• Enabling Machine Translation

• Using Auto-Suggest

• Saving Files

Opening and Translating a File

Translation involves opening the file to be translated and then submitting it to translation.

•    Opening and Translating Files •    Pseudo Translation

References:

•    Translation Preferences •    Accented Characters •    Configuring Transcheck

Opening and Translating Files

After a given project is opened , the various files that comprise the project are accessible from the
Project Files tab. When the project has numerous files, the files can be chained together into one
contiguous file, refer to Chaining Files.

To open a file for translation from the Project Files tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
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 3. On the Project Files tab, click Translate File.

The file open progress is shown and, upon completion, the TXLF Editor tab appears. The file content
is shown in the Source column.

 4. Select a Target segment.
 5. Enter the translation for this segment.

All tags in the Source segment should be either copied or entered manually into the Target segment.
 
6. Click Next Segment (or Alt+ ) to move down one Target segment.
 7. To save work:

a) Click the File tab.

b) Click Save (or Ctrl+S).
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When the translation is complete, the file should be saved as described in Saving Files.

Chaining Files

Multiple files can be combined and viewed as one file using Chain Files. For example, if you are
assigned ten files with ten segments each, these files can be chained into one large file of 100 segments
and opened as one file.

To chain a group of files into one file from the Project Files tab:

 1. Select the files to be chained.
 2. Click Chain Files.

The chained file opens in the TXLF Editor Translation tab under the name "Chained Files 1" (in
this example). In the Source Section, the segments are numbered as they were in the source file.
The source ID for each segment from a given file is sequentially numbered and the ID is given a
unique background color. Subsequent file segments are numbered in the same manner with a unique
background color.

 3. Click in segment three (3).



Chapter 10 - Translating Files Wordfast

Copyright © Wordfast, LLC 2016.   Page 97 of 227

Notice the file name changes to the name of the first file in the chain.

 4. Scan down the segments until segment ID-1 appears again and the ID background color changes.
 5. Click in segment one (1).

Notice the file name changes to the name of the second file in the chain.

 6. Scan down the segments until segment ID-1 appears again and the ID background color changes
again.

 7. Click in segment one (1).

Notice the file name changes to the name of the third (last) file in the chain.

 8. Save the chained file.
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When the chained file is saved, the segments are restored to their original files and the chained
format is not retained.

  Note:

Multiple of sets of chained files can be opened as well.

Chaining files is only for the editor view and they cannot saved as TXLF export documents.

The Jump To A Segment (Ctrl+G) and Last Modified Segment (Shift+F5) shortcuts are disabled on
chained files.

Translate All

To translate a project file from the Translation tab using Translate All:

 1. Click in the first source segment.

 2. Click Translate All.
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The translation proceeds and upon completion the screen is refreshed with the results.

Using Translation Memory

Translation memory (TM) is designed to provide maximum content re-use and facilitate collaboration
between globally distributed localization resources. The following is a list of those tasks and associated
procedures:

•    Leveraging Translation Memory •    Using TM Lookup

Leveraging Translation Memory

Translation Memory (TM) is a collection of previously approved translations, used to increase
consistency and speed up translation. When one or more translation memory files is active, suggestions
from the TM appear as a translation is entered into the target segment or when the Leverage tool is
used.

The Leverage tool differs from the automatic leveraging that takes place during translation in that it
provides an instant TM leverage of the selected segment using the most current TM available with a
number of leverage options.

To leverage Translation Memory from the Translation tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Select the file to translate.
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 4. Click Translate File.

The file is leveraged against the TM assets and the results are presented under the Translation tab
in the Target Segment column.

 5. Select the segment to leverage against the most current TM when Leverage is clicked.
 6. In the Segment or Automated section of the Tools ribbon on the Translation tab, click one of the

following:

• Leverage (or press Alt+–) to retrieve suggestions from the active TM for the selected source
segment

• Until Fuzzy (or press Ctrl+Alt+F) to retrieve suggestions from the active TM until the next Fuzzy
match

• Until No Match (or press Ctrl+Shift+PgDn) to retrieve suggestions that from the active TM for the
all source segments until no exact match is found
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The leveraged content from the TM appears if a match is found. When MT is enabled, the MT match
is populated.

Using TM Lookup

The Translation Memory lookup is used to view TM leverage results and concordance search results.
This search looks for specific source segment text in the translation memory. The results show source
and target segments.

Translation Memory leverage search occurs automatically, as a user navigates through the segments, to
provide the users with the best possible full segment matches from the TM. It is also the only search that
uses scoring to decide which match is the best.

To perform concordance search from the Translation tab:

 1. Enter a word or phrase in the TM Lookup text box as shown in the following example.

Using the string "vendor" searches segments ignoring case and includes matches containing any of
the specified words.

 2. Click Find Source or Find Target.
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Without using a case sensitive search there are numerous hits.

 3. To further refine the search, using the string VENDOR, select Case Sensitive under More Options.

More Options drop-
down.  

 

 

 

Option Description

Case Sensitive Filter by case.

Exact Filter for only those terms that appear in the same order.

Automatic Leverage Filter for TUs that are matched in the TM.

Diff Highlight Highlight the difference between source and TM source as well as
differences between target and TM target.

Include Private TU (GLTMS) Include private Translation Units in the search for remote GLTMS
TMs.
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Rerunning the search with Case Sensitive selected returns only one hit as shown in the following
example.

Using Glossaries

Glossaries are lists of source terms and their preferred translations. To set up a glossary refer to Working
With Terminology.

When a segment, under the Terminology tab, is selected all terms within that segment that are in the
glossary are highlighted and shown with their translation word in the Terminology pane. Using the Next
Term and Previous Term buttons moves the focus through all terms within that segment that are found
in the glossary.
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Editing the glossary from the Terminology pane:

• Add a term to the glossary, refer to Adding Glossary Terms

• Edit a term in the glossary, refer to Editing Glossary Terms

• Remove a term from the glossary, refer to Removing Glossary Terms

• Insert a term into the the target segment, refer to Inserting Glossary Terms

Adding Glossary Terms

Adding terms to a glossary from the Terminology tab:

 1. Do one of the following:

• Select a word in the source segment and the translation in the target segment

• Click the Add

Icon,  in the
Terminology pane.

The Add Term dialog box
appears.  

• Or, select a term in the source segment
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• Click the Add

Icon,  in the
Terminology pane.

The Add Term dialog
box appears.  

• Enter the translation
for the term in the
Target field

 2. Click OK.

Editing Glossary Terms

Editing terms in a glossary from the Terminology tab:

 1. Select the term to edit.
 
2. Click the Edit Icon, , in the Terminology pane.

The Edit Term dialog box
appears.  

 3. Make the editorial changes.
 4. Click Modify.

Removing Glossary Terms

Deleting terms in a glossary from the Terminology tab:

 1. Select the term to delete.
 
2. Click the Remove Icon, , in the Terminology pane.



Chapter 10 - Translating Files Wordfast

Copyright © Wordfast, LLC 2016.   Page 106 of 227

A Remove confirmation pop-
up appears.  

 3. Click Yes.

Inserting Glossary Terms

Inserting a term into the current target from the Terminology tab:

 1. Click in the target segment where the insertion is to take place.
 
2. Click the Insert Icon,  in the Terminology pane.

The selected term is inserted into the target segment at the selected point.

Working with Tags

A tag is inline text that is wrapped in a special character pair and is not translatable; for example, HTML
code tags within a sentence. Target segments should have the same tags as the source segment.
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However, depending on the language, sometimes a tag is not needed. If an attempt is made to save a
target segment with missing tags, a warning message appears.

Below is a list of the tag related tasks:

• Viewing Tags

• Copying Tags
• Clearing All Tags

• Deleting Tags
• Editing Tags

Viewing Tags

To view tags from the Translation tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Select a file for translation.
 4. Click Translate File.
 5. Click the Translation tab.

The file appears under the Translation tab. If tags exist in the source segment, they appear in purple
if they are formatting tags and gray for non-formatting tags. The first tag in a selected segment
appears in red.

The tags in the source segment are highlighted. For example, the numeral one in highlighted in red to

indicate selected ( ) is a tag and should be copied into the target segment.
 6. Mouse over a tag to view the tool-tip information as shown in the following example.
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The text as it appears in the tag is shown in the following tool-tip snippet.

  Note:

Tags should not be edited or deleted. Refer to Configuring Tags for more information on tag
preferences such as mode, representation, and font size.

Copying Tags

Tags can be selected and copied individually (Copy).

 1. Click Translate File on the Project Files tab.
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 2. To copy tags from the Translation tab, select the tag to be copied.
 
3. Drag the selected tag into the target segment or click Copy (Ctrl+Alt+ ).
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The source and target segments are highlighted. Once the tag is copied, the next tag is automatically
selected.

The tag is highlighted in red and selected as shown in the following example.

 4. Click Copy All Tags in the Tags section of the Translation tab to expand the drop-down menu.

The Copy All Tags menu appears as one of the two shown.

  

a) Select one:

• Segment to copy only the tags for the selected segment to the target

• Document to copy all tags for the entire document

b) Enter the translation between the copied tags, if necessary.

Copied tags appear at the location of the cursor. They must be reordered to appear correctly.

c) Drag and drop the translated text, or cut and paste the translation between the tags.

Editing Tags

To edit tags from the Translation tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
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 3. Select a file for translation.
 4. Click Translate File.

The file appears under the Translation tab.
 5. Select a segment to edit.

If tags exist in the source segment they are shown.
 6. Highlight the tag to be edited in the target segment as shown in the following example.

 7. To open the Edit Tag dialog box, right-click on the tag and select Edit Tag from the drop-down menu.

Reference: Translation Edit Drop-
down Menu

The Edit Tag dialog box
appears.  
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  Note:

Tags in the source segment should not be edited.

Ensure that all tag edits are valid, otherwise the TXLF file could become corrupt.

 8. Make the tag modifications.
 9. Click OK.

Deleting Tags

The tag can be deleted only in the target segment.

To delete tags:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open a project.
 3. Select a file.
 4. Click Translate File.
 5. Click the Edit tab.

The file content appears in the Translation workspace. If tags exist in the source segment, they
appear in purple if they are paired tags and gray for non-paired tags. The first tag in a selected
segment appears in red.

 6. In the target segment of the Translation dialog box, select the tag for deletion.
 7. Select the tag to delete with a cursor scan.
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 8. Delete the tag by doing one of the following:

• Press Delete

• Click Cut on the Options ribbon

• Press Ctrl+X

• Press Backspace

Reference: Translation Edit Drop-down Menu

The Undo option is available on the Options ribbon.

Clearing All Tags

Tags can be cleared only from a target and either the current segment or from the entire document.

To clear all tags from the current target segment through the Translation tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Select a file.
 4. Click Translate File.
 5. Click the Translation tab.
 6. Place the cursor within the target segment.

 7. Click Clear All Tags.
 8. Select one of the following:
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• Segment from the
drop-down menu to
clear all tags from the
segment

• Document from the
drop-down menu to
clear all tags from the
document

    

  

A warning pop-up appears.  

 9. Click Yes to complete the removal.

Finding and Replacing Content

Text in translated content can be searched for and replaced using the Find / Replace option.

To find and replace text in a file from the Translation tab:

 1. Go to the Projects list tab (refer to Opening Projects).
 2. Select and open the project.
 3. Click the Edit tab.
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The Edit tab appears.

 4. Do one of the following: 

•    Click Find/Replace

•    Press Ctrl+F

 

The Find/Replace dialog box
appears.  

 5. Under the Find tab, enter the search text in the Find What: field.

  Note:

Search arguments can include non-breaking spaces.

 6. Click Find Next repeatedly to move through all occurrences of the term.
 7. Select Reading Highlight to toggle the highlighted term in the submission.
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Find/Replace dialog
box.  

Replace Tab Option:
 8. Select the Replace tab to replace terms.
 9. Enter the find text and replacement text.
 10. Click one of the following:

• Replace, to replace the found content only

• Replace All, to replace the found content and all other instances of that content

• Find Next, to move to the next instance of the term

Replacing text in Find/
Replace dialog box.  

More Options:

Option Description

Backward Search from cursor location to file beginning.

Forward Search from cursor location to file end.

Ignore Case Search for all instances of a word or phrase ignoring case.

Whole Words Only Search for all instances of only whole word matches.
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Option Description

Ignore Non-breaking Space
Search for all instances of a word or phrase including non-breaking
spaces.

Search Source Search for all instances of a word or phrase in the source only.

Search Target Search for all instances of a word or phrase in the target only.

Search Through Open Files Search for all instances of a word or phrase in all open files.

Using Table Filter

The Table Filter option provides the means to search for specific text using a number of filter criteria.
The Translation tab is shown with the search bar bordered in red.

An explanation of the Table Filter toolbar (shown above) is presented in the following table.
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Item Description

The Source/Target filter menu options are:

• Source restricts the search to the source language segments.

• Target restricts the search to the target language segments.

• Source and Target directs the search to both source and
target.

• Source or Target directs the search to either source or target
(default).

Directs search to be case-sensitive.

Drop-down list field Specify the text that is the object of this search.
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Item Description

Drop-down list of all available search filter criteria:

• 100% match segments– segments matching completely in TM

• All except 100% and In Context match segments– segments
with partial TM match, no match, or modified segments

• Auto-propagated segments– all auto-propagated matches

• Committed segments– segments with translated content
committed to the TM

• Context match segments– all segments matching context

• Duplicate segments– segments being duplicated in the file

• Edited source segments– source segments that have
changed

• Empty target segments– segments without a translated target

• Fuzzy match segments– segments with partial TM match

• Machine translated segments– segments translated by
machine—Note: requires Machine Translation be enabled in the
project.

• Modified segments– segments modified through auto-
propagation

• No match segments– segments with no match in the TM

• Segments with transcheck errors– segments with non-
linguistic errors or repeated words

• Segments with history– segments with a change list

• Segments with notes– segments containing comments

• Segments with repetitions– segments with repeated text
strings

• Short segments– segments of fewer than {#} words,
paragraphs or other blocks

• Unconfirmed segments– segments marked unconfirmed

Apply the selected filter.

Accumulate a filter selection filters to apply in order of selection

Clear all fields in Table Filter tool bar
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Item Description

Sort the filtered results by selected criteria where Document is
selected by Default

Configure options for the Table Filter using the dialog box (shown in
the following graphic*) to enter a maximum word count

* The Table Filter pop-up
dialog box.  

Using Notes

While translating or reviewing translated content, notes specific to each segment can be added as
described here.

Wordfast Pro opens in the Projects tab. Double-clicking a project opens the Project Files tab. For
additional information refer to Opening Projects.

A project's notes are accessible through the Review tab after a project file is opened.
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Begin with the Review tab where the following Notes options are available:

• Viewing Notes

• Adding Notes
• Editing Notes

• Deleting Notes
• Exporting Notes

Viewing Notes

To view notes from the Review tab:

 1. Select the file where notes are to be viewed.
 2. Double-click a file or click Review File.

The file appears under the Translation tab.

Notice the Note icon in the status column of the third segment.
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 3. Click the Notes tab in the lower-left portion of the screen, Editor Tabs section.

The attached notes are listed in this section as shown in the following segment of the TXLF Editor.

Adding Notes

To add a note from the Review tab:

 1. Place the cursor in the segment where the note is to be added.
 2. Use one of the following methods to open the Notes dialog box:

•    Click Add in the Notes section
of the Review tab.  

 

•    Click Add under Notes tab of
the Editor.  
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The Add/Edit Notes dialog box
appears.  

  

•    Right-click the segment and
click Add (or press Alt+Shift+N).

 

 3. Select the note Type.
 4. Enter the note text.
 5. Click OK.

The note appears in the lower left section of the Review tab under the Notes tab and the Notes icon
appears in the Status column.

Editing Notes

To edit a note from the Review tab:

 1. Place the cursor in the segment where the note is to be edited.
 2. Select the note to be edited.
 3. Use one of the following methods to open the Notes dialog box:

•    Click Edit in the Notes section
of the Review tab.  
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•    Click Edit under Notes tab of
the Editor Tabs section.  

 

•    Right-click the segment and
click Add (or press Alt+Shift+E).

 

 

The Add/Edit Notes dialog box
appears.  

 4.  Edit the note.
 5. Click OK.

The modified note appears in the lower left of the screen in the Editor Tabs section under the Notes
tab.

Deleting Notes

To delete notes from the Review tab:

 1. Select the segment where the note is to be deleted.
 2. Select the note to be deleted.
 3. Use one of the following methods to delete the note:

•    Click Delete in the Notes
section of the Review tab.  
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•    Click Delete under Notes tab
of the Editor.  

•    Right-click the segment and
click Delete (or press Alt+Shift
+D).

 

Exporting Notes

To export notes in Microsoft Word format from the Review tab:

 1. Click the Review tab.
 2. Select the note(s) to export.
 3. Click Export.

The Export Notes dialog box appears.

 4. Verify or change the save folder.
 5. Enter a name for the file.
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 6. Select the Microsoft Word file type.
 7. Click Save.

The file is saved in the specified location and should be reviewed by browsing to the note file and
opening it.

Working with Segments

Segments are parts of the file that are divided by formatting or punctuation. Typically, segments are
sentences, but may be words or numbers, depending on the formatting of the source file. When a file
is converted to a translatable TXLF format, all complete sentences become separate segments. Once
these segments are translated, they are saved and committed to the Translation memory and leveraged
in future translations. Translation Memory leveraging reduces the time and expense of future translations
by automatically and consistently translating reoccurring words and phrases.

Refer to the following tasks:

• Viewing Segment History

• Committing to Translation Memory

• Unconfirming or Confirming a Segment

• Copying All Sources

• Locking Segment

• Clear Target

• Copying Source

• Clear All Targets

• Editing Source
Segments

References:

• Leveraging Translation Memory

Viewing Segment History

The Segment History tab is used to view the segment changes in the currently open file. In the following
example, the segment was modified twice on the same day.
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Committing to Translation Memory

After translating all the source segments, Translation Memory should be updated. The changes must be
committed to the Translation Memory. The Commit All tool should be used to update all target segments
from TM. The Commit tool only updates the current target segment from TM.

To update Translation Memory use Commit All as follows:

 1. Click Commit All in the Translation Memory section (or press Ctrl+Alt+End).

The Translation Memory is updated for the current segment (Commit) or the entire document
(Commit All).

Copying Source

Source can be copied to targets from the TXLF Editor Translation tab using Copy Source.

To copy segment source text to the segment target:

 1. Select a source segment.
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The associated target segment is highlighted based on that color selected within Preferences >
Colors.

 2. Expand Copy Source options.

•   Click a Copy Source
option:   

The source segment is copied to the target.
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Copying All Sources

All source content can be copied into all targets from the TXLF Editor Translation tab (as shown) using
Copy All Sources.

To copy all source segments to the all target segments:

 1. Click Copy All Sources.

Locking Segment

Confirmed, proofed, and translated segments can be locked to ensure that they are not changed.



Chapter 10 - Translating Files Wordfast

Copyright © Wordfast, LLC 2016.   Page 130 of 227

To lock a segment:

 1. Open the TXLF Editor Translation tab as shown.

 2. Select the segment to lock.
 3. Click Lock Segment.

The Locked Segment icon appears in the Status column of the selected segment.

Clear Target

The selected target content can be cleared using Clear Target.
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 1. Select the target segment.
 2. Click Clear Target.

A confirmation warning appears.  

 

 3. Click Yes to complete the target clearing.

Clear All Targets

All target content in a file can be cleared from the TXLF Editor Translation tab using Clear all Targets.
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1. Click Clear All Targets.         

A confirmation warning
appears.  

 2. Click Yes to complete the clearing.

Unconfirming and Confirming Segments

The Unconfirm/Confirm Segment option allows the translator to mark a segment for future reference. For
example, if the translator wants to check and confirm a segment after referring to some resources, the
segment can be marked unconfirmed.

Unconfirmed segments cannot be committed to the TM.



Chapter 10 - Translating Files Wordfast

Copyright © Wordfast, LLC 2016.   Page 133 of 227

Individual segments can be unconfirmed or confirmed in separate actions through the TXLF Editor
Translation tab (refer to Opening Projects). All segments can be confirmed in one action. See the
following:

• Unconfirming or Confirming a Segment

• Unconfirming or Confirming All Segments

Unconfirming or Confirming a Segment

To unconfirm or confirm a segment from the Translation tab:

 1. Select and open the project.
 2. From the Project Files tab, double-click the file.
 3. Click the Translation tab.
 4. Enter a translation, or leverage the target segment from the Translation Memory by clicking the TM

Lookup tab in the lower left portion of the screen.

The target segment appears.

 5. Click Unconfirm / Confirm on the tab (or press Alt+Enter).

The Unconfirmed icon appears next to the segment in the Status column (shown above).
 6. To confirm the segment, click Unconfirm/Confirm on the tab.

The Unconfirm icon is removed from the Status column.
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Unconfirming or Confirming All Segments

To unconfirm or confirm all segments from the Translation tab:

 1. Select and open the project.
 2. From the Project Files tab, double-click the file.
 3. Click the Translation tab.

The file appears in the Translation workspace. The first translatable segment appears in a blue
background and the cursor is placed in the target segment.

 4. Enter a translation for each segment, or leverage the target segments from the Translation Memory.
 5. Click the Unconfirm / Confirm All drop-down menu.
 6. Click one of the following:

• Unconfirm All (or press Alt+Shift+Enter)

• Confirm All (or press Ctrl+Shift+Enter)
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The Unconfirm icon appears next to the segments in the Status column when Unconfirm All is
selected in the previous step, as shown in the following example.

 7. Click Confirm All to reverse the Unconfirm All.

Editing Source Segments

The Edit Source option allows you to modify the source content of the file being translated. The original
source content is stored in the TXLF file and can be restored at any time.

To edit the source segment from the Edit tab:

 1. Double-click the file.

The file appears on the TXLF Editor Translation tab.
 2. Select a segment.
 3. Click the Edit tab.
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The TXLF Editor Edit tab appears.

 4. Place the cursor within the segment source.
 5. Click Edit Source in the Source Actions section.
 6. Edit the source content as needed.
 7. Click off the edited segment.

The screen segment highlights the
symbol used to indicate an edit took
place.  

 

An Edited Source icon appears in the
Status column.

To revert to original source, click Revert Source in the Source Actions section.
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Using Transcheck

The Transcheck option verifies certain elements in the target segments and warns about missing or

incorrect text or variables. For example, if a tag or type text is incorrectly entered, a warning icon ( )
appears before the target segment. When you mouse over the warning, details appear.

The following are the related tasks:

• Enabling Transcheck

• Running Transcheck All
• Viewing Transcheck Warnings

Enabling Transcheck

Transcheck options are tied to a specific project. To enable Transcheck and customize the options for a
project refer to Configuring Transcheck.

Running Transcheck All

The Transcheck All Segments scans all segments of a file for non-linguistic errors in the target
segments and warns about missing and/or incorrect text. This should be done before completing a file.

To check all segments of a file from the TXLF Editor Review tab:

 1. Select the file to be checked.
 2. Click the Review tab.
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The Review tab of the TXLF Editor appears.

 3. Click Transcheck All.

All segments of the file are checked and a Transcheck report is generated.

Transcheck All Reports

After Transcheck is run on all segments, two reports are generated. The detailed Transcheck report
opens in a separate Web page and a summary is shown in a Transcheck Report pop-up.

The detailed Web report opens as shown in the following example, as long as pop-ups are not blocked
by the browser.
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Detailed Transcheck Report (page 1)
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Detailed Transcheck Report (page 2)
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Detailed Transcheck Report (page 3)

Summary Transcheck Report
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Viewing Transcheck Warnings

Warnings generated when running Transcheck can be viewed under the Transcheck (0) tab in the
lower-left area if Transcheck during translation is selected in Transcheck Preferences (refer to
Configuring Transcheck).

To view Transcheck warnings from the TXLF Editor Files tab:

 1. Select a file.
 2. Click Translate File.

The file is validated and displayed in a TXLF Editor Files tab.
 3. Click the Review tab.
 4. Click Transcheck All.
 5. Click in the first target segment.

 6. Click the Transcheck (2) tab in the lower left area of the screen, referred to as the Editor.

The "(2)" indicates the number of errors in this segment.

The Transcheck warnings are shown there as the segments are stepped through.
 
7. Navigate to next segment by clicking Next error under the Transcheck (x) tab (or press Alt+ )

As each segment is clicked, a warning appears if and when errors are encountered.
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 8. Click:

• Go back to fix error to return to the segment and correct the error

• Continue to return to the translation

If the error is not corrected, the Transcheck error icon remains in the Status column and under the
Transcheck tab in the Editor tabs area.

Enabling Machine Translation

Wordfast Pro includes an automated machine translation feature that populates translations whenever
a file is open or when there are no Translation Memory segment matches. To enable specific Machine
Translation options, refer to Configuring Machine Translation.

Enabling Auto Propagation

Translations for segments can be set to propagate in the document automatically when a segment
is committed to Translation Memory. Enabling the Auto Propagation option permits the leveraging
of repetitive content from previous translations. For more information, refer to Configuring Auto
Propagation.
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Using Auto-Suggest

The Auto-Suggest option populates suggestions based on source content, such as numbers, URLs and
proper names. It can also suggest terms for the glossary, Translation Memory (TM) matches, and sub-
segment TM matches. To enable this option see Configuring Text Tools.

Leveraging Repetitive Content

Leveraging repetitive content re-uses segments that are repeated in a file. For example, if there are
multiple instances of the phrase Our Process, then the translator needs to type the translation only
once. The remaining segments are leveraged, updated automatically when Auto Propagation is enabled
(see Configuring Auto Propagation).

To leverage repetitive content from the TXLF Editor Translation tab:

 1. Select a file.
 2. Click Translate File.

The file appears in the Translation workspace of the Translation tab.

 3. Select the first translatable segment. It changes to a blue background with the cursor in the target
segment.

 4. Enter the text in the target segment for the first instance.
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Suggestions from the TM appear as the translation is entered. The target segment appears in a pink
background.

 5. Select a suggestion, or continue entering the translation.
 6. Commit the term by using one of the following methods:

• Click Commit (or press Alt+End)

• Click Next (or press Alt+ )

The entered target segment is saved to the TM and automatically propagates this target segment
for all repeats of the source segment throughout the file. When the term is committed to TM, the
translation is automatically propagated throughout the file.
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Saving Files

To save one's work and prevent a loss before completion, use one the options below.

 1. In the Save Options section of the TXLF Editor File tab, click one of the following:

• Save to save the active
file to  a local drive
manually.     

• Save to save the active
file to a local drive
manually under a different
name.     

• Save File As Translated to
save the translated file to a
local drive.  

A pop-up progress bar appears and upon completion, the file is on a local drive.
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Quick Tools 11
Quick Tools provides a collection of tools for users to create and work with files outside of projects.
These tools are primarily used by Project Managers before sending the files to translators.

 1. Open Wordfast Pro.

  Note:

The Projects, Location, Source Language, and Target Language columns can be ordered by

typing the first letter or two of the item to head the list then clicking  or  to the far right. These
columns can be searched by typing in a string of characters that are contained in the entry of interest.
When a matching, unique string is found in an entry, only that entry is presented in the list. To restore

the list, click the Clear Filters icon .
 2. Click the Wordfast 4 tab to expand the drop-down menu.

Refer to Quick Tools for more information.
 3. Click Quick Tools.
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Refer to the following sections for more information on Quick Tools:

• To run a project file analysis, refer to Analyzing Project Files

• To clean up and update the Translation Memory, refer to Cleanup

• To preview what is translatable and the complexity of formatting in the target, refer to Pseudo
Translation

Analyzing Project Files

In analyzing a project's files for translation, the source files are analyzed against Translation Memory
and generates a report listing matches, non-matches, word count, and character count as well as the
total number of segments. This process can greatly improve efficiency while reducing the time and effort
spent by the translator.

The file Analysis can also create TXLF files from the source files that can then be sent to linguists for
translation.

Another use of the file Analysis is in generating quotes based on the word and character count.

Analysis can be accomplished in either of the following ways:
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• Analyzing an entire project from the Project Files tab, refer to Analyzing Projects

• Analyzing individual files of a project from the Quick Tools tab, refer to Analyzing Files

Analyzing Files

In Analyzing files for translation, the selected file(s) are analyzed against a Translation Memory to
leverage reusable content and execute a pre-translation (refer to Analysis Tab).

To analyze files from the Quick Tools tab:

 1. Click the Analysis tab.

 2. Add the file(s) to be analyzed.
 3. Select the appropriate settings and provide export report information (refer to Configuring Translation

Memory).

a) Select the Translation Memory to use.

b) Select the Options:

• Fuzzy match threshold with the percent match

• Copy all tags

• Copy source on no match
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• Create TXLF files

• Enter a TXLF file location
 4. Select the Report Settings:

a) Calculate analysis report percentage by:

• Words

• Segments

b) Select to Calculate internal fuzzy matches with the percent match.

• Select Include internal fuzzy matches as TM matches

c) Select the report format from the drop-down list, in this case report summary.
 5. Click Analyze Files.

A pop-up appears showing the report percentage progress.

The analysis completes and the Report File summary appears (shown below).

Cleanup

The Project Manager is responsible for the cleaning up of translated files and selecting the TM update
options. The file cleanup process requires a manual initiation.
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Cleanup processes bilingual files (TXML files containing source and target). The source files are returned
to their original format and the bilingual files are converted to files in the target language using the
original format. (Refer to Working with Segments.)

Optionally, the TM can be updated during cleanup.

As a final step, a report is generated indicating the number of segments processed, errors encountered,
and TM update results.

To clean up and update the Translation Memory using Quick Tools:

 1. Select Quick Tools from the Wordfast 4 drop-down menu.
 2. Click the Cleanup tab.

 3. Click Add File.
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The file Open dialog
box appears.  

 4. Select a file.
 5. Click Open.

The Cleanup tab reappears with the selected files.
 6. Optionally, select an Update Option for updating files to a Translation Memory.

The TM Update
Options pull-down list
is shown to the
right. 

• Select the
Translation
Memory to use.

  Note:

At least one Translation Memory is needed before file clean up can be initiated (refer to Working with
Project Translation Memory). To add a local or remote Translation Memory, refer to Creating Local
Translation Memory for more information.

 7. Click Clean Up.

A pop-up appears showing the percentage progress.

Upon completion, the CleanUp Report summary appears.
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Pseudo Translation

Pseudo translation copies the source content to a target where the content has accented characters and
the text is expanded by twenty percent. The pseudo translation provides a preview of what content will
be selected as translatable and how complex formatting appears in the target. Both source files or TXLF
files can be pseudo translated.

To pseudo translate files:

 1. Click Quick Tools in the Wordfast 4 drop-down menu.

The Quick Tools tab appears.
 2. Click the Pseudo Translation tab.
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 3. Select the file format for pseudo translation, to pseudo:

• Translate a TXLF file, select and add a TXLF file

• Translate a source file, select Source, and select the Pseudo translation Options
 4. To browse and select files from a folder, click Add File under File.
 5. To browse and select a folder click Add Folder under File.
 6. Select the files to be pseudo translated.

  Note:

Only one format can be selected at a time.

 7. Click Pseudo Translate.
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A confirmation pop-up appears upon
completion.  

Note: Up to 20 files can be processed
at a time using Wordfast Pro in Demo
mode. To pseudo translate more than
20 files, a Wordfast Pro license is
required.

The pseudo translated files are placed in the same folder as the source file. An example of a pseudo
translated TXLF file is shown below.
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Appendix 12
This appendix includes reference material for:

• Accented Characters

• Application Tabs

• Preferences

• TXLF Editor Unlabeled Icons

• WorldLingo Languages

Accented Characters

The table below lists the letters with supported accents.

Accent Sample Key Combination Notes

Acute Ó ó Ctrl+', V '= apostrophe key

V= any vowel

Circumflex Ô ô Shift+Ctrl+^, V

Grave Ò ò Ctrl+`, V

Tilde Ñ ñ Shift+Ctrl+~, V Only works with "n, N, o, O, a, A"

Umlaut Ö ö Shift+Ctrl+:, V := colon key

Some examples follow:

1. To enter the character "ó", (Ctrl+',o) hold down the Control key and press the apostrophe key.
Release both keys and press "o". The accented letter appears.

2. To enter the character "Ó", (Ctrl+',O) hold down the Control key and press the apostrophe key.
Release both keys and press "O". The accented letter appears.

3. To enter character "ñ", (Shift+Ctrl+~,n) hold down the Shift key and press the Control key, then
press the tilde (~) key. Release all three keys and press "n".

The following table lists other supported foreign characters.

Character Name Key Combination Notes

¡ Upside-down exclamation
point

Alt+Shift+Ctrl+!  Press and hold Alt+Shift+Ctrl+!

¿ Upside-down question mark Alt+Shift+Ctrl+?  



Chapter 12 - Appendix Wordfast

Copyright © Wordfast, LLC 2016.   Page 157 of 227

Character Name Key Combination Notes

Ç, ç French C cedille (caps/
lowercase)

Ctrl+, ,c

Ctrl+, ,C

For ç, press Control, then the comma
key. Release then press c.

Œ, œ OE ligature (caps/
lowercase)

Shift+Ctrl+&,o

Shift+Ctrl+&,O

Press and hold Shift+Ctrl+&, release
the keys and press o

ß German Sharp/Double S Shift+Ctrl+&,S

Ø, ø Nordic O slash (caps/
lowercase)

Ctrl+/,o

Ctrl+/,O

Å, å Nordic A-ring, Angstrom
sign (caps/lowercase)

Shift+Ctrl+@,a

Shift+Ctrl+@,A

A with ring/Angstrom Sign

Æ, æ Old English AE ligature
(caps/lowercase)

Shift+Ctrl+&,a

Shift+Ctrl+&,A

Ð, ð Old English eth (caps/
lowercase)

Ctrl+',d

Ctrl+',D

Icelandic/Old English eth

' = apostrophe key

Application Tabs

The following is a list of application tabs for this product:

• Project Files Tab

• Project Terminology Tab

• Project Reference Files Tab

• Project Help Tab

• TXLF Editor—File Tab

• TXLF Editor—Edit Tab

• Project Translation Memory Tab

• TXLF Editor—Translation Tab

• Reports Tab

• Quick Tools

• TXLF Editor—Formatting Tab

• TXLF Editor—Terminology Tab

• TXLF Editor—Review Tab

Project Files Tab

The following is the Project Files tab and its options.
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  Note:

The Files and TXLF File Location columns can be ordered by typing the first letter or two of the

item to head the list then clicking  or  to the far right. These columns can be searched by typing in
a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

File Section

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Add a file or files for translation to
the project.

No Shortcut

Add a folder containing files for
translation to the project.

Ctrl+O

Open selected file for translation.

Combine all selected files to
open as one.
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Project Section

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Close an existing project.

No Shortcut

Modify project name or languages.

No Shortcut

Clean up the file and update the
TM after translation is complete.
Refer to Cleanup.

No Shortcut

Analyze project's files for
translation against a TM to
leverage reusable content and pre-
translate files. Refer to Analyzing
Projects.

No Shortcut

Check for non-linguistic errors in
the project's translated content.
Refer to Using Transcheck.

No Shortcut

Create a report of changes to
segments.

No Shortcut

Export notes added to the
segment as a separate report.

   

Package Section

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Import a package (.glp) into the
tool.

No Shortcut

Prepare a package (.glp) for
export.
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Options Section

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Remove selected file(s) from the
project.

F9

View or change the current
preferences.

Project Translation Memory Tab

The following is the Project Translation Memory (TM) tab.

  Note:

The Translation Memory and Location columns can be ordered by typing the first letter or two of

the item to head the list then clicking  or  to the far right. These columns can be searched by typing
in a string of characters that are contained in the entry of interest. When a matching, unique string is
found in an entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon

.

The following tables describe the various options of the Project TM tab.
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Translation Memory Section

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+Shift+N

Create a new local local TM.

Ctrl+N

Add local TM.

No Shortcut

Connect to remote TM.

Ctrl+Shift+G

Open the TM in the TM Admin
view.

Ctrl+Shift+T

Modify selected TM.

Ctrl+Shift+C

Copy selected TM.

Import/Export Section

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+Shift+I

Import existing TM.

Ctrl+Shift+E

Export selected TM.

Options Section

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+Shift+R

Remove selected TM(s) from the
project.

F9

View or change the current
preferences.

  Note:

Refer to Configuring Translation Memory for usage details.
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Project Terminology Tab

The following is the Project Terminology tab.

  Note:

The Glossary Name or Blacklist Name and Location columns can be ordered by typing the first

letter or two of the item to head the list then clicking  or  to the far right. These columns can
be searched by typing in a string of characters that are contained in the entry of interest. When a
matching, unique string is found in an entry, only that entry is presented in the list. To restore the list,

click the Clear Filters icon .

The following tables describe the various elements of the Project Terminology tab.

Terminology Section

Icon Shortcut / Description Icon Shortcut / Description

Alt+N

Create a local glossary or
terminology.

Alt+O

Add a local glossary or
terminology.

No Shortcut

Connect to a remote glossary or
terminology.

Alt+G

Open the selected glossary.
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Icon Shortcut / Description Icon Shortcut / Description

Alt+I

Import a glossary.

Alt+E

Export the selected glossary.

Blacklist Section

Icon Shortcut / Description Icon Shortcut / Description

Alt+B

Create a local blacklist.

Alt+C

Add a local blacklist.

No Shortcut

Connect to a remote blacklist.

Alt+H

Open a blacklist.

Alt+J

Import a blacklist.

Alt+K

Export a blacklist.

Options Section

Icon Shortcut / Description Icon Shortcut / Description

Alt+M

Modify the selected glossary.

Alt+R

Remove the selected glossary.

F9

View or change current
preferences.

   

Reports Tab

The following is the Reports tab.
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  Note:

The Report Name and Location columns can be ordered by typing the first letter or two of the item to

head the list then clicking  or  to the far right. These columns can be searched by typing in a string
of characters that are contained in the entry of interest. When a matching, unique string is found in an

entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon .

The following table describes the various options of the Reports tab.

Options Section

Icon Shortcut / Description Icon Shortcut / Description

Alt+Z

Remove the selected report(s).

Alt+U

Export a report in the following
formats:

•  PDF           •  HTML

•  XLS           •  CSV

Project Reference Files Tab

The following is the Reference Files tab.
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  Note:

The File Name and Location columns can be ordered by typing the first letter or two of the item to

head the list then clicking  or  to the far right. These columns can be searched by typing in a string
of characters that are contained in the entry of interest. When a matching, unique string is found in an

entry, only that entry is presented in the list. To restore the list, click the Clear Filters icon .

The following table describes the options available through the Reference Files tab.

Options

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Add a reference file to the
project.

No Shortcut

Open a reference file in the
project.

No Shortcut

Show instructions for the project
from the Project Manager, if
added.

Alt+0

Remove the selected file(s) from
the project.

Project Help Tab

The following is the Help tab.
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  Note:

The options on this tab are identical to those on the TXLF Editor tabs.

The following table describes the various options of the Help tab.

Help Options

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

View and select the available
updates to the product.

No Shortcut

Register and check
expiration of the product
license.

No Shortcut

View the product name,
version, build, and copyright.

Ctrl+Alt+H

Access online help for
the product.
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Quick Tools Tab

The Quick Tools tab is accessed through the
Wordfast 4 drop-down menu.  

When Quick Tools is selected from the
Wordfast 4 drop-down menu the Analysis
tab opens.

Refer to the following for Quick Tools
options:

• Analysis Tab

• Clean Tab

• Pseudo Translation Tab

• Project Help Tab

Analysis Tab

The following is the Analysis tab that is accessed through Quick Tools.
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The following tables describe the options of the Analysis tab.

File Section

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Add a file or files for analysis.

No Shortcut

Add a folder of files for analysis.

No Shortcut

Remove files from those selected
for analysis.
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Actions Section

Icon
Reference

Shortcut / Description   

No Shortcut

Begin the analysis.
   

Translation Memory Section

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Create a local Translation
Memory file.

No Shortcut

Add a local Translation Memory
file.

No Shortcut

Connects to remote Translation
Memories.

Ctlr+Shift+B

Adds a project Translation
Memory.

No Shortcut

Remove a Translation Memory.
   

Options Section

Icon Shortcut / Description Icon Shortcut / Description

F9

Customize the General,
Translation, and Project
preferences.

   

Clean Tab

The following is the Clean tab that is accessed through Quick Tools.
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The following tables describe the options of the Clean tab.

File Section

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Add a file or files for analysis.

No Shortcut

Add a folder of files for analysis.

No Shortcut

Remove files from those selected
for analysis.
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Actions Section

Icon Shortcut / Description   

No Shortcut

Initiate a cleanup process on the
open file.

   

Translation Memory Section

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Create a local Translation
Memory file.

No Shortcut

Add a local Translation Memory
file.

No Shortcut

Connects to remote Translation
Memories.

Ctlr+Shift+B

Adds a project Translation
Memory.

No Shortcut

Remove a Translation Memory.
   

Options Section

Icon Shortcut / Description   

F9

Customize the General,
Translation, and Project
preferences.

   

Pseudo Translation Tab

Pseudo translation copies the source content to a target where the content has accented characters and
the text is expanded by twenty percent. Pseudo translation provides a preview of what content will be
selected as translatable and how complex formatting appears in the target.
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The following is the Pseudo Translation tab that is accessed through Quick Tools.

The following tables describe the options of the Pseudo Translation tab.

File Section

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Add a file or files for analysis.

No Shortcut

Add a folder of files for analysis.

No Shortcut

Remove files from those selected
for analysis.

   

Actions Section

Icon Shortcut / Description   

Ctrl+Shift+Y

Initiate a pseudo translation
process.
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Options Section

Icon Shortcut / Description   

F9

Customize the General,
Translation, and Project
preferences.

   

Quick Tools Help Tab

The following is the Help tab that is accessed through Quick Tools.

Refer to Project Help Tab for more information on the options of this tab.

TXLF Editor—Edit Tab

The following is the TXLF Editor view of the Edit tab.
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The options on the TXLF Editor Edit tab are shown in the following tables.

Clipboard Section

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+Z

Undo most recently entered text
or performed function.

Ctrl+Y

Redo most recently deleted text
or re-perform undone function.

Ctrl+X

Remove selected text from target
segment (only) retaining it for
later use.

Ctrl+C

Copy the selected text to the
clipboard.

Ctrl+F, Ctrl+H

Search target segments for text
and replace with specified text.

Ctl+V

Insert copied text at the location
of the cursor in the target
segment.

Source Actions Section

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Edit the source segment.

No Shortcut

Revert the edited source to the
original state.

Options Section

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+Shift+8

Show white space in the
document as a middle dot
(·).

F9

Customize the General,
Translation, and Project
preferences.
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TXLF Editor—File Tab

The following is the TXLF Editor view of the File tab.

The options of the File tab are shown in the following tables.

File Section

Icon Shortcut / Description   

Ctrl+W

Close the active file.

 

 
 

Save Options Section

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+S

Save the file.

F12

Save the file to a different
location and/or save with a
different name.

Ctrl+Alt+S

Save the translated file in its
original format.
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Options Section

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+Alt+P

Show the translation as a
preview in a Microsoft Word
document.

No Shortcut

Show instructions for the project
provided by the project manager.

No Shortcut

View the translated project file.

   

TXLF Editor—Formatting Tab

The following is the TXLF Editor view of the TXLF Formatting tab.

The options on the TXLF Editor Formatting tab are shown in the following tables.

  Note:

These options are only available when formatting is supported by the file type.
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Format Section

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+B

Format the selected text as bold.

Ctrl+I

Format the selected text as italic.

Ctrl+U

Format the selected text as
underlined.

Ctrl+=

Format the selected text as
subscript.

Ctrl+Shift+=

Format the selected text as
superscript.

Ctrl+K

Format the selected text with
strike-through indicating deleted,
without deleting it.

Tags Section

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Show actual tag content for
active segment (if supported).

No Shortcut

Show the formatting tags content
for active segment.

Options Section

Icon Shortcut / Description Icon Shortcut / Description

No Shortcut

Used to insert a left-to-to-right
marker in the segment.

Ctrl+Shift+Space

Used to insert a non-breaking
space in the segment.

No Shortcut

Used to insert a right-to-to-left
marker in the segment.
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Other Section

Icon Shortcut / Description

Ctrl+D

Attach and detach (make floating toolbar) these Segment options.

TXLF Editor—Review Tab

The following is the Wordfast TXLF Editor Review tab.

The options on the TXLF Editor Review tab are shown in the following tables.

Check Section

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+Shift+Q

Check for non-linguistic errors in
the translation.

F7

Run spell-check over the entire
translation.

No Shortcut

Highlight the spelling errors in the
completed translation.
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Notes Section

Icon Shortcut / Description Icon Shortcut / Description

Alt+Shift+N

Add a note to the segment being
worked on.

Alt+Shift+E

Edit the selected note.

Alt+Shift+D

Delete the selected note.
  

No Shortcut

Export notes.

TXLF Editor—Translation Tab

The following is the TXLF Editor Translation tab.

The following tables present the TXLF Editor Translation tab options.

Segment Section

Icon Shortcut / Description Icon Shortcut / Description

Alt+

Commit current segment to the
TM and leverage next translatable
segment.

Alt+

Commit current segment to the
TM and leverage the previous
translatable segment.
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Icon Shortcut / Description Icon Shortcut / Description

Alt+Q

Commit the current segment to the
TM remaining in place.

Alt+ -

Leverage the TM for the current
source segment.

Alt+S

Copies the source segment content
into the target segment.

Ctrl+Alt+Insert

Copies all source segments into
the target segments.

Alt+PgDn

Combine two or more segments
from a single paragraph.

Alt+PgUp

Separate the selected segment
into two segments.

Ctrl+Alt+Y, Alt+Shift+Delete

Clear the selected target or clear all
targets in document.

No Shortcut

Lock the selected segment to
prevent changes.

Alt+Enter

Mark the selected segment as
unconfirmed so that the translation
is not saved into the TM.

Alt+Shift+Enter, Ctrl+Shift
+Enter

Mark all segments as
unconfirmed to prevent their
being saved into the TM.

Automated Actions Section

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+Alt+F

Translation proceeds until the
first TM fuzzy-match encounter.

Ctrl+Shift+PgDn

Translation proceeds from the
TM until the first TM no-match
encounter.

Ctrl+Shift+End

Translation proceeds ignoring
TM fuzzy-match and no- match.
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Translation Memory

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+Alt+End

Save translated segments to
TM without closing files after the
translation is complete.

Ctrl+SpaceBar

Analyze the selected Translation
Memory.

F8

Search the TM for the selected
text with the results in the TM
Lookup Editor Tabs section.

Ctrl+Shift+M

The active segment (only) is
machine translated.

Tags Section

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+Alt+

Select the previous tag.

Ctrl+Alt+

Select the next tag.

Ctrl+Shift+V, No Shortcut

Delete all tags in the target.
Options:

• Clear all tags in the
segment, click Segment

• Clear all tags in document,
click Document

Ctrl+Alt+

Copy the currently selected tag or
term from the source to the target
at the location of the cursor.

Alt+Shift+P, Alt+A

Copy tags or terms from source
document to the target, or All Tags
from segment.

No Shortcut

Enable editing of the selected tag.
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Translation Edit Drop-down Menu

The TXLF Editor Translation
Edit drop-down menu.  

TXLF Editor—Terminology Tab

The following is the TXLF Editor Terminology tab.

The following tables present the TXLF Editor Terminology tab options.
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Term Section

Icon Shortcut / Description Icon Shortcut / Description

Ctrl+0

Copy the selected term.

Ctrl+F5

Toggle Run and Stop highlighting
terms.

Ctrl+9

Select the next term.

Ctrl+8

Select the previous term.

TXLF Editor Unlabeled Icons

Translation files are TXLF files and users can edit these files using the TXLF Editor tool. The unlabeled
icons used throughout TXLF Editor are shown in the following table.

Icon Description Icon Description

Transcheck error. A non-linguistic
error has occurred in the segment.

A note has been added to the
segment.

The segment has been repeated.
The segment is locked and cannot be
edited.

The segment is not confirmed in the
TM.

Information is available.

Apply the selected table filter. Accumulate the selected table filters.

Reset the Terminology search Filter
criteria.

Clear the filters in a search.

Select the term search target for
Terminology and Table Filters.

Expand or collapse the options
ribbon.

Expand or collapse the lower panel.
Click to add a term to the
Terminology list.
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Preferences

The Wordfast Pro preference options are accessible through Preferences and by pressing F9.

The preferences categories and sub-categories are listed below.

1. General Preferences:

• Customizing Colors

• Customizing Icon Appearance

• Customizing Shortcuts

• Customizing Fonts

• Customizing Application Layout

• Customizing Warnings

2. Translation Preferences:

• Configuring Tags

• Configuring Text Tools

• Configuring Machine Translation

• Configuring Auto Propagation

• Configuring Spell Check

3. Current/New Project Preferences:

• Configuring Translation Memory

• Configuring Penalties

• Configuring Segmentation

• Configuring Terminology

• Configuring Transcheck

• Configuring Filters

4. User Preferences are the Advanced Settings as follows:

•    Default Preferences Settings •    Export/Import Preferences Settings

General Preferences

General preferences cover the following topics:
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• Customizing Colors

• Customizing Fonts

• Customizing Icon Appearance

• Customizing Application Layout

• Customizing Shortcuts

• Customizing Warnings

Customizing Colors

Varying colors are used to differentiate between types of content in the TXLF editor. This color usage
can be customized through Preferences—General Preferences.

To customize the color usage for translation from Preferences:

 1. Click Colors in the General Preferences section.

The current translation color settings appear.
 2. To change the color for any Item Name, click the colored image in the Color column.

 

For example, click the colored image
in the Color column for item No Match
and the color palette appears.  

 

•    Select purple.

•    Click OK.

 

The color code for the selected item is
changed to purple.
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 3. Click OK to save the change(s) and close the Preferences.

Customizing Fonts

The fonts for the various application tools can be customized in the Preferences—Fonts section.



Chapter 12 - Appendix Wordfast

Copyright © Wordfast, LLC 2016.   Page 187 of 227

The following tables list the standard fonts and associated sizes.

Application Specific Fonts

Application Font Name Font Size

TXLF (TXML) Editor Font Arial 13

TM Lookup Font Arial 12

Glossary Lookup Font Arial 12

Blacklist Editor Font Arial 13

Translation Memory Editor Font Arial 13

Terminology Editor Font Arial 13

Notes View Font Arial 12

Segment History Font Arial 12
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Application Font Name Font Size

Transcheck Font Arial 12

Adding Language Specific Fonts

Language Font

Bengali Bangla

Malayalam Kartika

Telugu Gautami

Tamil Latha

Kannada Tunga

Afrikaans Arial

Afrikaans (South Africa) Arial

Chinese SimSun

Chinese (Taiwan) PMingLiU

Chinese (China) SimSun

Hebrew Arial

Hebrew (Israel) Arial

Japanese MS Gothic UI

Japanese (Japan) MS Gothic UI

Korean Batang

Thai Tahoma

Thai (Thailand) Tahoma
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Language Font

Vietnamese: Arial Arial

Vietnamese (Vietnam): Arial Arial

Customizing Icon Appearance

The icons appearance on the various tabs can be modified to the extent of relative size and the inclusion
or exclusion of the icon title by navigating to Preferences then Icons as described below.

To customize the icon appearance from Preferences:

 1. Click Icons.

The two icon appearance options (relative size and title) appear.

 2. Select a preferred icon size.
 3. Select Display text to enable or disable the inclusion of description text with the icons.
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Customizing Application Layout

The layout preferences provide some control of the Editor view. Customize the general layout options by
navigating to Preferences then:

 1. Click Layout.

The layout preferences appear.

 2. Modify the layout options in the following criteria table.

Table View

Option Description

Hide ID Column Hide the segment ID column.

Hide Score Column Hide the Translation Memory score column.

Hide Table Header Hide the editor table header.
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Score Column Position

Option Description

Before Target Place the Translation Memory score column before the target
segment column.

After Target Place the Translation Memory score column after the target
segment column.

Segment

Option Description

Automatically leverage first segment View the Translation Memory leverage of the first open
segment when you open a TXLF file for translation.

Automatically open last edited
segment when opening a file

Go to the last segment edited when a file is opened.

Next/Previous Segment (TM
Commit) action leverages next/
previous segment

Enable or disable the writing and leveraging action of the
Next/Previous Segment command.

Skip Unedited 100% Matches Enable or disable skipping over those segments with perfect
matchs.

Skip Unedited Context Matches Enable or disable skipping over those segments with context
matching.

Layout

Option Description

Keep the last layout open Always keep the previous edit view open.

Layout—Current Project

Option Description

Display Locale Codes in Current
Project View

Always include locale information in the view for current
projects.
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Option Description

Display Full Language Name in the
Current Project View

Always include the complete language name in the view for
current projects.

Status Bar—Current Project

Option Description

Language Codes Include the language codes on the Status Bar.

Full Language Name Include the complete language name on the Status Bar.

Customizing Shortcuts

To select keyboard shortcuts, navigate to Preferences and then:

 1. Click Shortcuts in the General Preferences section.

The options list to customize keyboard shortcuts appears for the Application scheme.
 2. Select a scheme from the Scheme drop-down list.

 3. Select a Command from the command list.

In the example below, the Terminology Highlight shortcut is selected.
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 4. Select that command to access edit mode.
 5. Press the new sequence of keys, beginning with Ctrl or Alt, Ctrl+Shift+F7 in the Shortcut column.

 

In the event that the shortcut key sequence is in
use a warning pop-up appears.  

 

The shortcut key is modified to that specified.

  Note:

A new shortcut key sequence must begin with a Ctrl or Alt, or must be a Function key (F1).

 6. Click OK.

Customizing Warnings

The messages that are presented to the user can be limited to some extent. Most of the messages
—referred to here as warnings—are selected by default. To modify the warning inclusion list, select
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or deselect the check box for a given warning to enable or disable that warning. To customize the
messages presented, navigate to Preferences.

To select warnings:

 1. Click Warnings.

The Warnings dialog box appears.

 2. Select the warnings to be displayed in the application.

Translation Preferences

The Translation Preference categories are:
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• Configuring Tags

• Configuring Text Tools

• Configuring Spell Check

• Configuring Auto Propagation

• Configuring Machine Translation

Configuring Tags

Configure the tag mode, representation, and font size by navigating to Preferences then Tags as
described below.

  Note:

The project as configured in Project Director (PD) may not support formatting tags.

To modify tag settings from the Preferences option:

 1. Click Tags under Translation Preferences.

The Tags options list appears.

 2. The tag options are listed in the following tables, modify the options as required.

Text Formatting
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Tag Option Description

Show Text Formatting Show actual formatting associated with formatting tags (when
supported). When selected, a preview appears.

Show Formatting as Tags Show the content of the formatting tags. When selected, a preview
appears, as shown in the example above.

Tag Naming

Tag Option Description

Full Name View full name of the tag. For example, Font.

Short Name View short name of the tag. For example, F.

Numbering View the tag as a number.

Automatically remove
incomplete tag pairs

Delete incomplete or incorrect tags.

Automatically apply
segment formatting

Automatically apply formatting to the entire segment.

Capitalize First Letter Capitalize the first letter of the first word in the segment.

White Space Character

Tag Description

Display spaces and NBSPs
in the editor

Show all spaces including non-breaking white spaces as a middle
dot (·).

Configuring Auto Propagation

Auto Propagation allows repetitive content in the file to be translated consistently, by propagating
translated segments. The Auto Propagation options control which segments are candidates for auto
propagation.

To edit the Auto Propagation preferences, navigate to Preferences and then:

 1. Click Auto Propagation.
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The Auto Propagation preferences options list appears.

  Note:

Auto Propagation is enabled by default and must be enabled to use the Auto Propagation options
listed below.

 2. Deselect Enable Auto-Propagation to disable Auto Propagation.
 3. Select Enable auto-propagation across all open files to apply Auto Propagation to all open files.
 4. Review the Auto Propagation options to ensure that those required are the only ones selected. The

options are described in the following table.

Option Descripton

100% Matches Overwrites 100% leveraged Translation Memory (TM) matches.

Fuzzy Matches Overwrites partial Translation Memory matches.

Autopropagated
Matches

Overwrites all auto-propagated matches. This means that if there are
multiple segments that have the same content, then editing one segment
auto-propagates the change in all matching segments.
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Option Descripton

Edited Segments Overwrites edited segments. This allows segments that have been edited
to be overwritten by Auto Propagation.

Machine Translated
Segments

Overwrites machine translated content.

Committed Segments Overwrites translated content which is committed to the Translation
Memory (TM).

Configuring Text Tools

The Text Tools preferences offer the following configuration options for the text editor:

• The Auto-Suggest option populates suggestions based on source content, such as numbers,
URLs, and proper names. It can also suggest terms for the glossary, Translation Memory (TM)
matches, and Sub-segment TM matches.

• The Smart Quote option automatically changes the quotation marks to smart quotes when the
user presses the quotation mark keys on the keyboard, depending on the target language.

To configure the text editor options, navigate to Preferences and then:

 1. Click Text Tools.
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The options for the text editor appear.

 2. Select Enable Auto-Suggest checkbox, to enable Auto-Suggest.

With Auto-Suggest enabled, there are four options under Enable suggestions for:

a) Click Source to enable suggestions for sources of the segment: numbers and capitalized words
only.

b) Click Glossary to enable suggestions for terms from the glossary.

c) Click TM to enable suggestions for translations from the TM.

d) Click TM Sub-Segment to enable suggestions for parts of segments from the TM.
 3. Select Enable Smart Quotes checkbox to enable automatic conversion of standard quotes to smart

quotes (quotation marks).

Depending on the target language, the quotation marks used when the user presses the quotation
mark keys on the keyboard are changed.

Configuring Spell Check

Enabling the spell check option is a good practice to ensure high quality. Spell check is supported in
Microsoft Windows and Hunspell.

To enable or disable spell check navigate to Preferences and then:

 1. Click Spellchecker.
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The Translation Preferences for Spellchecker options appear. If this is a new project, the default,
Enable Spell Checking, is enabled.

 2. Select or deselect Enable Spell Checking.

Enabling spell checking adds the option to enable spell checking while text is being entered.
 3. If Check Spelling as you Type is enabled, select one of the following:

• Microsoft Office as the spell checking service

• Hunspell as the spell checking service
 4. Click OK to save the settings.

  Note:

If spell checking is disabled, all spelling preferences are cleared. To select spelling preferences,
select Enable Spell Checking.

Configuring Machine Translation

The automated Machine Translation (MT) feature populates translations whenever a file is open or when
there are no Translation Memory segment matches.

To enable Machine Translation and select options, navigate to Preferences and then:

 1. Click Machine Translation.
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The Machine Translation options appear.

 2. Select one of the following:

• Perform when there is no TM match, to show machine translated content when there are no
match segments.

• Always perform Machine Translation, to show machine translated content when a segment is
leveraged. TM matches appear in TM Lookup with the MT matches.

 3. Select check boxes to allow all unedited segments in active document to be leveraged with MT, and
to remove MT score from score column when segment is edited.

 4. Select Google Translate, Microsoft Translate, or WorldLingo as primary machine translator. Google
Translate, Microsoft Translate, and WorldLingo can all be enabled at one time, but only one can be
selected as primary machine translator.

 5. Select the options for each machine translator, and perform any additional tasks as required by the
machine translator.
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Translator Options

Enable Google
Translator

Enable Microsoft
Translator

Enable
WorldLingo

Languages are limited. Refer to WorldLingo Languages.

 6. Read the disclaimer carefully.
 7. Click OK.

Current/New Project Preferences

If this is being accessed for a new project, the preferences are all set as defaults. For current projects,
the preferences reflect whatever has been set up for this project by the Project Manager. These
preferences cover the following topics:

• Configuring Translation Memory

• Configuring Terminology

• Configuring Penalties

• Configuring Transcheck

• Configuring Segmentation

• Configuring Filters

Configuring Translation Memory

To configure Translation Memory settings for a project from Preferences:

 1. Click Translation Memory.
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The Translation Memory options list for the current project appears.

The following steps apply to the Translation Memory section.
 2. Select Write unedited fuzzy..., to commit unedited fuzzy and exact matches to a TM.
 3. Select Copy source when..., to copy the source to the target segment when there is no match and

the TM is leveraged.
 4. Select the Fuzzy Match Threshold percentage.

  Note:

This value specifies the TM leverage percentage limit for a fuzzy match. For example, if a value of
75% is entered, the tool marks all the translations which are leveraged below 75% match as a 'No
match' segment.
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 5. Select the analysis Report Settings:

• Calculate analysis report Percentage by: Words or Segments

• Calculate Internal Fuzzy Matches in: Percentage and Include Internal Fuzzy Matches in TM
Matches

 6. Select only one condition to be followed when editing an existing Translation Unit. The options are as
follows:

• Add to TM by overwriting the existing TU (default): Overwrite the existing Translation Unit

• Add to TM; overwrite the existing TU if attributes are identical: Overwrite the existing
Translation Unit if the attributes match

• Only add to TM the new TU; do not overwrite the existing TU: No overwrite, just add new TUs
to the existing Translation Unit

• Add to TM; do not overwrite the existing TU: No overwrite, just add TUs to the existing
Translation Unit

• Do not add to TM: No addition to be made to the existing Translation Unit
 7. Select the Number of TM lookup hits.

The following steps apply to the Replaceables section.
 8. Select Enable replaceables for higher TM matches to replace the selected segments in the

translation with segments from the selected TM.

Selecting this option selects all sub-options by default. Select or deselect the terms to be replaced or
not to be replaced from the Translation Memory as listed below:

a) De-select Number replacement if not wanted

b) De-select URL replacement if not wanted

c) De-select Punctuation replacement if not wanted

d) De-select Email address if not wanted
 9. Click OK.

The Translation Memory properties for the project are set up.

Configuring Terminology

Terminology lists (glossary) are used to leverage previously translated text, resulting in lower costs and
greater consistency.

To select Terminology options for a project from Preferences:

 1. Click Terminology in the Current Project Preferences section.
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The Terminology (Glossary) preferences appear.

 2. Select Enable Fuzzy Terminology, to view fuzzy matches.
 3. Select the number of hits (matches) to be viewed.
 4. Select Enable term highlighting as you type, indicate terminology matches by highlight when

entered in the translation.
 5. Select Ignore case for term highlights, to ignore case difference in terminology matches.
 6. Click OK.

Configuring Penalties

Penalties are defined to maintain a high quality of content leveraged from Translation Memory. A relative
value is assigned to each of the penalties, which are then taken into account when calculating the
translation score. This score is used to differentiate between golden or 100 %, fuzzy, and no match.

To define penalties for a project from Preferences:

 1. Click Penalties.
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The Penalties preferences for the current project appear.

 2. Select the categories desired and supply their thresholds. The following table shows a list of penalties
with their descriptions.

Penalty Description

Case Differences in case is considered.

Non Literal Differences in special characters, including punctuation, space,
apostrophe, dash, quote, etc.

Tag Differences in tagging.

Whitespace Differences in blank spacing.

Align Differences in Translation Units with alignment attributes.

Machine Translation Differences in Translation Units based on Machine Translation.
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Penalty Description

Multiple Translation Differences in Translation Units based on duplicates within the TM with
different translations.

Local TM Differences in Translation Unit from local desktop copy (Not Supported).

Remote TM Differences in Translation Unit from remote TM.

Private TU Differences in work-group Translation Unit from remote TM.

Public TU Differences in non-work-group Translation Unit from remote TM.

Secondary TM Indicates more than one TM is permitted and includes the maximum as
selected.

Attribute Differences in attributes.

If Attribute is Not When custom attribute in the Translation Unit does not match the text box
attribute.

If Filename Attribute
Does Not Match

When the file name attribute in the Translation Unit does not match the
TXLF file name.

 3. Click OK.

Configuring Transcheck

Transcheck is specific to a given project and it verifies certain elements in the target segments and
warns of missing or incorrect text or variables. For example, if a tag is missing or incorrect text was
entered, a warning symbol appears before the target segment. The warning is shown when one hovers
the mouse over the text.

To customize the Transcheck settings from Preferences:

 1. Click Transcheck under Current Project Preferences.
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The Transcheck settings appear.

 2. Select Transcheck segments while translating to enable Transcheck for this project.
 3. To check for specific errors in the target segments, select the different configuration settings as

described in the following table.

Setting Description

Transcheck segments
while translating

Check to enable Transcheck during translation.

Select/Deselect All Check to enable all of the following options.
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Setting Description

Blacklist Check Check if the target segment includes blacklisted terms.

Note: The blacklisted term list must be a tab-delimited file. This check is
available depending on the TMGR configuration for the project. Refer to
Configuring Blacklist Check

Capitalization Check Check differences in capitalization. To configure this option, refer to
Configuring Capitalization Check.

Edited Context Match
Check

Check if context matches from the TM were edited.

Edited Exact Match
Check

Check if exact matches from the TM were edited.

Edited Source Check Check if the source of a segment was edited.

Empty Target Check Check for empty target segments.

Forbidden Characters
Check

Check if the target segment includes forbidden characters. Refer to
Configuring Forbidden Characters Check.

Number Difference
Check

Check if the numerals in the source segment match the target segment.
Refer to Configuring Number Difference Check.

Punctuation Check Check for consistency in punctuation between source and target
segments. Refer to Configuring Punctuation Check.

Repeated Word Check Check for repeated words in the translation.

Segment Length
Check

Check if the translation complies with preset limits on characters and
words. Refer to Configuring Segment Length Check.

Extended Punctuation
Check

Check for consistency in extended punctuation between source and target
segments.

Copied Source Check Check for copied source text in the target.
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Setting Description

Spelling Check Run spell check as the translation is entered.

Note: The translator must still download a preview file, and run spell check
on the final translation.

Tag Check Check for missing tags in the target segments. Refer to Configuring Tag
Check.

Terminology Check Check if the terms in the source segment are translated correctly based on
the glossary. Refer to Configuring Terminology Check.

Unconfirmed
Segment Check

Allow skipping of unconfirmed segments when there is an exact match
and/or context match.

Unedited Fuzzy Check Check if fuzzy matches were not edited. Information for Unconfirmed
Segment Check and Unedited MT Check missing.

Unedited MT Check Enable or disable unedited MT checking..

Untranslatable Text
Check

Check if the untranslatable content in source and target segments is
consistent. Refer to Configuring Untranslatable Text Check.

Untranslated Text
Check

Check if any segments are not translated; for example, if Copy Source was
used.

Whitespace Check Check for white space in the translation.

 4. Click OK.

The Transcheck configuration is complete and active for the current project.

Configuring Blacklist Check

To configure the checking for blacklisted words for a given project from the Preferences option:

 1. Click Transcheck.
 2. Select Blacklist Check.
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The related options appear.

 3. Select the appropriate options.

Option Description

Skip exact matches Do not check the blacklist when there is an exact match.

Skip context matches Do not check the blacklist when there is a context match.

Configuring Capitalization Check

To configure the checking for capitalization differences for a given project from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Capitalization Check.

The related options appear.

 3. Select the appropriate options.

Option Description

All Caps Mismatch Check text in the target that is all in upper case, when the
source is not all in upper case

First Word Case Difference Check Check the first letter of the first word is capitalized consistently
in source and in target.
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Option Description

Target Capitalization Mismatch
Check

Check upper case text in the target that is in lower case in the
source.

Source Capitalization Mismatch
Check

Check upper case text in the source that is in lower case in
the target.

Skip exact matches Disable or enable checking for capitalization on exact
matches.

Skip context matches Disable or enable checking for capitalization on context
matches.

Configuring Forbidden Characters Check

To configure the checking for forbidden characters from the Preferences option:

 1. Click Transcheck.
 2. Select Forbidden Character Check.

The forbidden characters check is enabled.

 3. Click Add to add or edit a forbidden character.
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Add a character to be forbidden over the NEW character string.

 4. Click Update.

To remove a forbidden character from Forbidden Character checking, highlight the character and
click Remove.

Configuring Punctuation Check

Punctuation Check ensures consistency in punctuation between source and target segments.

To configure punctuation checking from the Preferences dialog box:

 1. Click Transcheck.
 2. Select Punctuation Check.
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A list of current punctuation characters expands as shown.

 3. Click Add to add a new character to the default list of punctuation characters.

An example is shown.

 4. Click Update.

To remove a punctuation character from checking, highlight the character in the list and click
Remove.

 5. Select Double Punctuation Check to check for repeated punctuation.
 6. Click OK.
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Configuring Number Difference Check

To configure the number difference check for this session from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Number Difference Check.

The related option appears.

Configuring Segment Length Check

Check if the translation complies with preset limits on character and word count.

To customize the segment-length checking function from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Segment Length Check.

 3. Select those options that apply.

The options are explained in the following table.

Option Description

Strict Character Length Check (Zero means
unlimited)

Check minimum and maximum character length.

Character Expansion Check Check minimum and maximum character
expansion, as a percentage.

Word Expansion Check Check minimum and maximum word expansion,
as a percentage.
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Option Description

Attribute Character Max Length Check Check attribute text that exceeds the maximum
character length set in Project Director.

Skip exact matches Disable or enable checking for capitalization on
exact matches.

Skip context matches Disable or enable checking for capitalization on
context matches.

Configuring Tag Check

To customize the Tag checking operation from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Tag Check.

The related options appear as shown.

  Note:

The project may not be configured in Project Director (PD) to permit formatting tags.

 3. Select Tag Check and select any options that apply from the following list:

• Check for non-formatting tags

• Check for Source formatting missing in target

• Check for formatting that exists in target but not in source

• Skip exact matches when checking for capitalization

• Skip context matches when checking for capitalization
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Configuring Terminology Check

To configure the Terminology checking criteria from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Terminology Check.

The options appear.

 3. Select Terminology Check check box and any of the following options that apply.

• Enforce Term Case: Check based on exact case matching.

• Fuzzy Term Check: Include terms that approximately match.

• Skip exact matches when checking for capitalization.

• Skip context matches when checking for capitalization.

Configuring Untranslatable Text Check

To configure the handling of untranslatable text checking from the Preferences option:

 1. Click Transcheck.
 2. Locate and select Untranslatable Text Check.
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The Untranslatable Text Check expands to a dialog box.

 3. To retain the untranslatable text in the target segment, click Add.
 4. Enter the untranslatable text to be retained.
 5. Enter a custom regular expression as necessary.
 6. To remove untranslatable text from the check, highlight the text in the list and click Remove.
 7. Select Untranslatable Text Check check box then those options that apply.

• Skip exact matches when checking for capitalization.

• Skip context matches when checking for capitalization.

Configuring Whitespace Check

To configure white-space for this session from the Preferences option:

 1. Click the Transcheck button.
 2. Select Whitespace Check.



Chapter 12 - Appendix Wordfast

Copyright © Wordfast, LLC 2016.   Page 219 of 227

Configuring Segmentation

These preferences specify how files should be segmented by the TXLF editor for a given project.

 1. Open Wordfast Pro and select a project from the project list.
 2. Click Open Project.
 3. Click Preferences under Options.

The overall preferences setup panel appears.
 4. Click Segmentation in the Current Project Preferences section.
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The Segmentation options appear.

The balance of the Segmentation options are shown below.

 5. Select the required segmentation options. These options are:

• Select Segmentation on break to enable segmentation on line breaks.

• Select APPLICATION or SRX for where to apply this from the drop-down list.
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 6. Define the characters that end a segment (ESM):

• Enter specific characters into the input field to specify custom segment end characters

• Select Space to enable white-spaces as a segment end character

• Select Tab to enable tabs as a segment end character

• Select Non Breaking Space to enable non-breaking white-spaces as a segment end character

• Select Line Feed to enable line-feed ASCII codes as a segment end character

• Select Carriage Return to enable carriage return ASCII codes as a segment end character
 7. Define the rules for the markers, select those that apply:

• A number followed by an end of a segment marker.

• Segment ends in a segment marker without a trailing space character.

• Segment ends in a segment marker, followed by a space character and a lower-case letter.
 8. Select abbreviations that should not be used in segmenting, see the following dialog box segment.

Configuring Filters

There are common file filters that can be enabled for a given project by navigating to Preferences then
Filters as described below.

 1. Open Wordfast Pro and select a project from the project list.
 2. Click Open Project.
 3. Click Preferences under Options.

The overall preferences setup panel appears.
 4. Click Filters.
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The Current (New) Project filter options appear. If filter preferences are being set for a new project
this display indicates New Project Preferences and the default filter settings are active. When filter
preferences are being reviewed or changed for an existing and currently open project the active filter
settings are shown and the display indicates Current Project Preferences.

 5. To select the file filter settings for the open project, click a filter to list the current settings in the
Format Settings box.

To add custom file filters, see Adding New File Filters.

Adding New File Filters

If the default settings of the filter of your choice is not sufficient, a new filter can be created based on one
of the supported filters.

  Note:

Only file filters that appear in the list of filters can be modified into additional file filters with a new
Symbolic Name.

To add a new file filter:

 1. Open Wordfast Pro and select a project.
 2. Click Open Project on the Project List.
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 3. Click Preferences under Options.

The overall preferences setup panel appears.
 4. Click Filters.

The Configure source file filters appears listing Available filters.

 5. Click Add.
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The New Filter dialog box appears.

 6. Select the desired filter to use as a template for a new filter.
 7. Supply the information and make appropriate selections.
 8. Click OK to save the modified filter as a new filter.

User Preferences—Advanced Settings

The User Preferences comprise the Advanced Settings as follows:

• Restore a Wordfast Pro installation to Default Preferences Settings

• Export/Import Wordfast Pro Export/Import Preferences Settings

Default Preferences Settings

This Preferences option provides the means to restore the current preferences of a Wordfast Pro
installation to factory or default settings.

To restore Wordfast Pro to factory settings, navigate to Preferences then Advanced Settings as
described below.

 1. Open Wordfast Pro.
 2. Click Preferences under Options.
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The overall preferences setup panel appears.
 3. Click Advanced Settings.

The dialog box to restore, export, or import the current settings of a Wordfast Pro installation appears.

 4. In the Default Settings section, click:

• Restore Factory to revert this Wordfast Pro installation preferences to those of a new installation.

• Restore Defaults to revert this Wordfast Pro installation preferences to default preferences.
 5. Click OK to complete the restore process.

Export/Import Preferences Settings

This Preferences option provides the means to Import and Export the current preferences of the
Wordfast Pro installation.

 1. Open Wordfast Pro.
 2. Click Preferences under Options.

The overall preferences setup panel appears.
 3. Click Advanced Settings.
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The options to restore, export, or import the current settings of a Wordfast Pro installation appears.

 4. In the Export/Import Preferences Settings section, click:

• Import to apply saved preferences.

• Export to save the current preferences for a given Wordfast Pro installation.
 5. Click OK to complete the Export/Import process.

Translation Memory Color Representations

The following table lists the default colors and their representations for source and target segments in the
submission.

Color Representation Color Representation

Auto
Propagation

Segment was auto-propagated.
Term
Match

100% match of terms.

Committed
TM

Segment was committed (modified and
updated) to translation memory.

Context
Match

Matched context from preceding
and following segments.
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Color Representation Color Representation

Fuzzy
Match

Fuzzy, less than 100% match.
Fuzzy
Term
Match

Fuzzy, less than 100% term
match of terms.

Gold Match Exact TM match, 100%.
Machine

Trans
Segment was populated by
Machine Translation.

No Match No match or N/A.
Selected

Term
Active Source segment

Target
Changed

Target segment was modified since the
original file was created.

Term No
Match

No match found for the term.

These default colors can be customized as explained in Customizing Colors.

WorldLingo Languages

WorldLingo Machine Translation (MT) is limited to the language set listed below:

• Arabic

• Chinese Simplified

• Chinese Traditional

• Dutch

• English

• French

• German

• Greek

• Italian

• Japanese

• Korean

• Portuguese

• Russian

• Spanish

• Swedish
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